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EXECUTIVE SUMMARY
Introduction
Virtualizing your x86 servers and desktops with VMware technologies has the
potential to make your business more agile, efficient and profitable. Mid-size business
and small-to-medium enterprises benefit most when they can host multiple, mixed
workloads within a common infrastructure — compute, storage, networking and
virtualization. To support this virtualized environment of multiple, mixed application
workloads requires:
e Consistent, predictable performance for mission and business critical
applications
e Management of resource contention amongst applications
e Responding to performance storms without impact to other applications
e Management of solution based on business priorities

e Scaling performance and capacity with no disruption to the business

Combining the Fusion ioControl Hybrid Storage Appliance and Cisco Unified
Computing System™ (UCS) with VMware® virtualization technologies (vSphere® and
Horizon View) can create a solution for your business that properly runs multiple
virtualized applications, including business applications and virtual desktops, while
delivering the consistent predictable performance needed in a cost-effective solution. In
the labs at Principled Technologies, we configured the Fusion-io and Cisco UCS solution
to run steady state business-critical applications, such as online transaction processing
(OLTP) and Microsoft® Exchange, with a demanding VDI workload. This reference
architecture shows you how to implement these Fusion-io, Cisco, and VMware
components for your data center and validates how the solution performed in our
testing.

We tested the reference architecture solution by running a mixed workload
environment while conducting a 600-count boot storm, or influx of initiating VDI user
sessions. For our testing, the measure of success depended on the responsiveness of
OLTP and Exchange workloads without interruption or degradation related to I/O
contention during the most demanding conditions, such as a virtual desktop boot storm.

Objective
The objective of this reference architecture (RA) is to validate and quantify the
advantages and benefits of a solution based on Fusion ioControl Hybrid Storage with

Cisco UCS/Nexus Switches and VMware software for a mixed workload environment
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and how to extend storage performance without increasing spindle count or data center
footprint.

This RA also documents configuration best practices for the Fusion ioControl
Hybrid Storage Appliance in an environment running multiple virtualized applications.

Audience

The intended audience of this reference architecture is IT planners and decision-
makers within medium-sized businesses and small-to-medium enterprises. Solution
architects and value-added resellers may also find this reference architecture useful in
deciding how to plan solutions for their customers. This reference architecture is not
intended to be a comprehensive guide to deployment and configuration for every

component in this solution.

SOLUTION CONSIDERATIONS

Proper design of the solution for a mixed application VMware environment is
important because the server infrastructure needs abundant resources to handle the
high density VDI user count in addition to running critical workloads, such as OLTP and
Exchange. Your infrastructure should be provisioned to handle steady-state
performance requirements along with bursts of data traffic. The shared storage needs
to support the random IOPS that result from mixed applications along with surges of 1/0
traffic, such as VDI boot storm and virus scans.

The solution needs to meet the following requirements:
e Guaranteed I/O resources to mission-critical applications
e Support for a high density of virtual desktops per server

e Consistent and predictable user performance even during peak application
workload conditions

e Simple configuration, management
e Out of the box reporting and monitoring

e Low latency and high bandwidth for clustering, provisioning, and storage

interconnect networks
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SUMMARY OF MAIN FINDINGS

We discovered multiple advantages in the reference architecture solution.

e Guaranteed I/0 performance: By implementing ioControl QoS (Quality of
Service) policies in a mixed workload environment, Cisco UCS and Fusion
ioControl ensured mission-critical and business-critical storage tiers
received guaranteed I/O under the most demanding portions of the mixed
workload test. Our OLTP and Exchange workloads remained at optimum
performance, including during a 600 virtual desktop boot storm.

e Consolidation and VM density: The reference architecture solution
delivered performance without sacrificing density, supporting a mixed back-
office workload and 600 concurrent virtual desktop users without session
degradation.

e Out-of-the-box reporting and monitoring: ioControl came equipped with
easy-to-use monitoring and reporting tools useful to a system

administrator.

e Simple deployment: We unboxed, cabled, and configured the management

interface of the Fusion ioControl storage appliance in less than half an hour.

e Performance boost: The solution provided uninterrupted performance and
response times to all workloads tested. The addition of Fusion ioTurbine
software for VMware along with Fusion ioMemory within UCS added power
to our OLTP workload. This resulted in a 6X OLTP workload increase without
any performance degradation or increase in storage footprint.

e Flexible scalability: We tested with an ioControl n5-150 appliance and a
single chassis of eight UCS B-Series servers. Both solution components have
additional available resources to scale that do not require a redesign of the

solution or of the infrastructure.

SOLUTION COMPONENTS
Cisco UCS

The following Cisco components were utilized:
e Cisco UCS 6200 Series Fabric Interconnects
e Cisco UCS 2200 Series Fabric Extenders

e Cisco UCS 5108 Blade Server Chassis

e Cisco UCS B-series Blade Servers for applications and virtual desktop hosting
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Careful planning and management are required to maintain a fully redundant
network. Due to its unified fabric model, Cisco UCS is a solution that delivers automatic
network failover right out of the box—you do not need to configure any hardware or
software or purchase additional pieces.

You can manage your entire Cisco UCS infrastructure from anywhere with the
Cisco UCS Manager software, which is a highly available, single location for systems
management. UCS Manager can apply all firmware versions and updates to existing
servers, new nodes, and other hardware with the click of a mouse. Cisco UCS Manager
offers support for all current and previous generation UCS hardware models, including
both blade and rack servers.

As your network scales out, the Cisco UCS Central software consolidates all
management systems together into one dashboard. Regardless of the hardware in your
UCS deployment, you can manage it the same way from one unified interface. This lets
you optimize your infrastructure to match your workloads without sacrificing the
management capabilities of UCS Manager or adding additional management products.

The Cisco UCS chassis contains eight half-height bays in only 6U, provides up to
160 Gbps to each chassis, and is capable of providing 80 Gbps of bandwidth to any
blade. Cisco UCS allows customers to share bandwidth across the entire domain,
ensuring that servers that need the bandwidth will get it without requiring switches in
every chassis. The chassis requires no integrated switches, as switching is handled
upstream by the redundant Fabric Interconnect modules for the entire domain.

Our configuration consisted of a Cisco UCS 5108 Blade Server Chassis,
connected to a redundant pair of Fabric Interconnects, four links per fabric. This

provided 40 Gbps per fabric, for a total of 80 Gbps to the chassis.

VMware vSphere 5.1

We used the data center virtualization software VMware vSphere 5.1 in our
testing—the latest version of the application. VMware vSphere can virtualize CPU, RAM,
hard disk, and network resources for fully functional virtual desktops that can run
insulated and condensed operating systems and applications. The high-availability
features of VMware vSphere coupled with VMware Distributed Resources Scheduler
(DRS) and vMotion can allow for migration of virtual desktops from one VMware

vSphere server to another with little or no effect on end-users.

VMware Horizon View

VMware Horizon View is a desktop virtualization solution built on and tightly

integrated with VMware vSphere. This software allows customers to extend the value of
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VMware infrastructure and its enterprise-class features, such as high availability,
disaster recovery, and business continuity. VMware Horizon View includes
enhancements to the end-user experience and IT control. Support for VMware vSphere
uses the latest functions of the leading cloud infrastructure platform for highly available,
scalable, and reliable desktop services.

Fusion ioControl Hybrid Storage Appliance
The Fusion ioControl Hybrid Storage Appliance (see Figure 1) combines PCle
flash memory with disk. ioControl’s integrated storage QoS software allows you to

provision, prioritize, and control shared storage performance.

Fusion-io | IOCoRtrot

HYBRID STORAGE

Figure 1: The Fusion ioControl Hybrid Storage Appliance.

The ioControl n5 series storage appliances are available in several base models
that differ in flash and disk capacity, all of which have the ability to add additional flash
and disk to scale performance and capacity independently of one another. All ioControl
n5 models come with software to manage and monitor the array. Fusion-io provided an
n5-150 Hybrid Storage Appliance for this RA, with the following:

e 2.4TBioMemory flash capacity and 48TB raw disk capacity

e A wide range of software to support array specific features, including Storage
QoS, Dynamic Data Placement, Phased Data Reduction, Snapshot, and
Replication
For more information on Fusion ioControl Hybrid Storage Appliances, see

www.fusionio.com/products/iocontrol/.

Fusion ioControl can provision and prioritize storage resources with Quality of
Service (QoS) performance policies that are grouped into three different service levels.
QoS policies are assigned to each volume independently and define minimum IOPS,

throughput and maximum latency for each application. A QoS policy is assigned to a

Fusion-io Virtualization Reference Architecture: A Principled Technologies reference architecture 7
Deploying Server and Desktop Virtualization on
Fusion ioControl Hybrid Storage, Cisco UCS, and VMware


http://www.fusionio.com/products/iocontrol/

volume at creation and can be changed in real time as needs change. ioControl QoS was
a key advantage in the deployment of the mixed workload reference architecture.

Figure 2 provides detailed information on QoS levels for the ioControl array and Figure 3
shows a representative mixed workload environment in which guaranteed service levels

have been assigned.

. Bandwidth Target Latency Target
Service Level IOPS Target (MB/sec) (ms)
Policy 1 Mission-critical 75,000 750 10
Policy 2 Business-critical 30,000 375 20
Policy 3 Business-critical 15,000 150 40
Policy 4 Non-critical 7,500 75 100
Policy 5 Non-critical 1,500 37 250

Figure 2: ioControl QoS policy characteristics.

ioControl quality of service

Prioritized performance under severe load

Mission-critical Business-critical Non-critical

| )

as a» A
SQL/VDI Exchange VDI

Guaranteed
minimum
performance

Impactis prioritized

Figure 3: Guaranteed performance according to QoS service levels.
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Data protection

According to Fusion-io, “ioControl provides a number of data protection tools
built into their Hybrid Storage Appliance, such as snapshots, cloning, and asynchronous
replication. ioControl snapshots allow for timely data backups and significantly reduce
RPO and RTO times. In addition, ioControl asynchronous replication is a key component
for data migrations and business continuity solutions. ioControl is supported with major
backup and recovery products, including Veeam®. Fusion-io is a Veeam Technology
Alliance Partner and ioControl has been certified with Veeam Backup and Replication.

“Veeam enables the Always-On Business™ by providing solutions that deliver
Availability for the Modern Data Center™. Veeam recognizes the challenges in keeping a
business up and running at all times and addresses them with solutions that provide
high-speed recovery, data loss avoidance, verified protection, risk mitigation and
complete visibility. Veeam Backup & Replication™ leverages technologies that enable
the modern data center, including VMware vSphere, Microsoft Hyper-V, to help
organizations meet recovery time and point objectives (RTPO™), save time, mitigate
risks, and dramatically reduce capital and operational costs. Veeam Backup
Management Suite™ provides all of the benefits and features of Veeam Backup &
Replication along with advanced monitoring, reporting and capacity planning for the
backup infrastructure.

“Together, Veeam and Fusion-io provide a cost-effective solution using the
latest PCle-based solid-state shared storage, backup, recovery and replication
technologies for virtual workloads — guaranteeing predictable performance for business
critical applications, Quality of Service (QoS) for VM datastores and faster backup and
recovery times.”

For more information, visit go.veeam.com/fusion-and-veeam.html.

Cisco UCS Fusion ioDrive2 785GB adapter and Fusion ioTurbine

software’

Combining Fusion ioTurbine intelligent caching software with Fusion ioMemory
on a UCS B-series Blade Server provided a performance extension to ioControl without
increasing the datacenter footprint. This extension complements ioControl shared
storage performance by applying a low latency, high-performance, high-capacity read-

cache to Cisco UCS blade servers to immediately improve performance and relieve I/0

LjoControl SPX combines ioControl Hybrid Storage, ioTurbine for VMware, and ioMemory into a single solution sold and supported
by Fusion-io under a single part number. See www.fusionio.com/data-sheets/iocontrol-n5-spx.
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bottlenecks to the most performance intensive application in the mixed workload. This
is an optional component that we chose to test as part of this reference architecture.

Storage management with ioControl vCenter plug-in
A plug-in is available with ioControl that allows VMware vCenter to manage
ioControl. According to Fusion-io, the ioControl vCenter plug-in “simplifies the

provisioning and management of Fusion ioControl shared storage.” For an image of the

user interface, see Figure 4 below.

root, 10.128.226.100 YMware vCenter Server, 5.1.0, 799731
Getting Started - ' Datacenters ' Virtual Machines ' Hosts | Tasks & Events ' Alarms ' Permissions ' Maps

: Storage Processors Volumes Details
!'P“E,ﬁa!troh 10.128.80.11 /10.128.80.12
10.128.210.20/10128.210.22
Capacity
-
49 %
— Software Hard ~Projections [[Storage Processor A | Storage Processor &
version 3.0.9671
O Status: OK o Status: OK o Status: OK Events: €9 a u
25 308 243

Figure 4: Storage management with the ioControl vCenter plug-in.
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WORKLOADS

For the first test, we set up a mixed workload consisting of common virtualized
business applications and VDI to run in concert over a 90-minute period. We ran OLTP
(SQL) and Microsoft LoadGen (Exchange) in a steady state condition and then kicked off
a 600 virtual desktop boot storm. After the 600 virtual desktops reached an idle state
we started the VDI workload.

For the second test, we configured ioTurbine intelligent caching software with a
Cisco UCS Fusion ioDrive2 mezzanine card to cache the SQL database volumes and
repeated the first test with a heavy OLTP workload. Specific parameters for each
workload are as follows:

Login VSI workload

We used Login VSI to measure the Fusion ioControl and Cisco UCS common
virtualized business applications and VDI workload capabilities. The Medium workload is
the standard work load on the Login VSI v4 benchmark; it simulates a typical business
user’s work behavior by using productivity-related applications. We added users
incrementally every 20 seconds until all users were logged in. Login VSI measures
response time for several items, such as how long it takes to open a text file or
compress a file. These response times degrade as the number of active users attach to
the pool of desktops.

From the response times collected, Login VSI v4 initially calculates a system
baseline called VSlbase, which determines—in milliseconds—the response time on a
system while there is little to no load. The VSlbase is later used to calculate the VSImax
v4 threshold, which is the point the system under test will be considered saturated and
subsequently degrade end-user performance and experience. Once this point of
saturation is reached, Login VSI determines the VSImax v4 result, which is the maximum
number of active sessions on a system before saturation, degrading end-user
experience. A successful test will not reach VSimax v4.

For more information, see section 1.2.2 (Workloads: Medium workload) at

www.loginvsi.com/documentation/index.php?title=All settings.

VM parameters

e 24GB master desktop image
o Virtual desktop OS: Windows 7 Enterprise edition
o 1GBRAM
o 1vCPU
e Desktop application environment
o Microsoft Office 2010
o Internet Explorer
o Adobe Reader
o Adobe Flash

Fusion-io Virtualization Reference Architecture: A Principled Technologies reference architecture 11
Deploying Server and Desktop Virtualization on
Fusion ioControl Hybrid Storage, Cisco UCS, and VMware


http://www.loginvsi.com/documentation/index.php?title=All_settings

o Java/FreeMind
e VMware View 4GB change disk
e About 10 to 15 IOPS per desktop at steady state, 100 percent concurrency
o Number of sessions: 600
o Launch interval: 20 seconds
o Login VSI Workload: Medium
o Number of launchers: 24

Output
e Login VSl response time, depicted in graphs (VSImax = pass/fail)

OLTP (DVD Store) workload description

To simulate an OLTP workload, we used DVD Store, which is an open-source application
that models an online DVD store where customers log in, search for titles, and purchase movies.
Higher thread count and lower think times increase CPU utilization and IOPS. For more

information on DVD Store, please see en.community.dell.com/techcenter/extras/w/wiki/dvd-
store.aspx.

Medium OLTP (no ioTurbine)

Testing parameters

e Database size: 20 GB

e Number of databases: one per VM

e Number of threads per VM: 12

e Actual test run time: 90 minutes

e Think time: 100 milliseconds

e  Warm-up time: 15 minutes

e Ramp rate: 10 minutes
Additional VM parameters

e See Figure 32 for VM parameters

e Each SQL VM was built on a single VMDK file with volume segregation

e Each SQL VM was configured as per best practices (C:\binaries, E:\SQL
Database, L:\SQL Logs)

e ioTurbine was configured to utilize guest-based caching

e ioTurbine guest-based caching was applied to the E:\ drive on each of the
four VMs, which contains both the 50 GB test database plus the tempdb
database

e ioTurbine guest caching was not applied to the SQL .Idf files in the L:\ drive

Output

e Orders per minute (OPM)
Heavy OLTP (with ioTurbine)

The medium OLTP workload was repeated with the think time reduced to Oms.
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Exchange (Microsoft LoadGen)

The Microsoft Load Generator 2010 (LoadGen) benchmark performs tasks to
simulate a typical user generating mail activity on Microsoft Exchange Server 2010. We
divided our users into four mailbox databases, each with 100 users, for a total of 400
users/mailboxes. We ensured that performance was within acceptable RPC average
latency thresholds. For more information on Microsoft Load Generator 2010, please see
www.microsoft.com/downloads/details.aspx?Familyld=DDEC1642-F6E3-4D66-A82F-
8D3062C6FA98&displaylang=en.

Parameters

e Simulation: Two days
e Time: 90-minute duration
e 100 users per database (400 total)
e Client: Outlook 2007 Online
e Action profile: Outlook_200
e Mailbox profile: 100 MB
VM parameters

e See Figure 32 for VM parameters
Output

e RPC latency?

2 Microsoft states that successful testing requires RPC latency to remain below 50 ms. For more information, see
technet.microsoft.com/en-us/library/bb508871(v=exchg.80).aspx.
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SOLUTION ARCHITECTURE

Figure 5 presents an overview of the components from our solution and how
they connected to one another.

Management
network

Nexus 5010 Peerlink Nexus 5010

UCS 6248UP (Fabric A) UCS 6248UP (Fabric B)
UCS 5108 Blade Chassis
. . e
| | o Q 2
'
® ®, L
3
®, o ¥,
Il 1Gbps
M 10Gbps

Figure 5: Overview of solution components.

We installed and configured VMware vSphere 5.1 on all eight of the servers. The
three infrastructure servers were Cisco B200 M2 blades and the remaining five
application servers were Cisco B200 M3 blades. In the SQL/Exchange host c1-s7, we
installed one Cisco UCS Fusion ioDrive2 mezzanine card. Figure 6 details configuration
for each server.
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Server Memory .
Model Processors Adaptors Functional role
name (GB)
Infral Cisco B200 M2 | Intel Xeon X5670 96 M171KR-Q QlLogic CNA Infrastructure host
Infra2 Cisco B200 M2 | Intel Xeon X5670 96 M171KR-Q QlLogic CNA Infrastructure host
Infra3 Cisco B200 M2 | Intel Xeon X5670 96 M171KR-Q QlLogic CNA Infrastructure host
cl-s4 Cisco B200 M3 | Intel Xeon E5-2690 256 Cisco UCS VIC 1240 VDI host
cl-s5 Cisco B200 M3 | Intel Xeon E5-2690 256 Cisco UCS VIC 1240 VDI host
cl-s6 Cisco B200 M3 | Intel Xeon E5-2690 256 Cisco UCS VIC 1240 VDI host
) Cisco UCS VIC 1240, FIO SQL and Exchange
cl-s7 Cisco B200 M3 | Intel Xeon E5-2690 256
ioDrive2 host
cl-s8 Cisco B200 M3 | Intel Xeon E5-2690 256 Cisco UCS VIC 1240 VDI host

Figure 6: Detailed server configuration.

Setting up Fusion ioControl

We powered on ioControl and connected a notebook to the management
network interface on storage processor A. The factory default address is
192.168.100.100/24. After logging on, we edited the iSCSI and management addresses.

Figure 7 shows the ioControl user interface (Ul) as we configured network information.
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Welcome, admin | Log Out System Health OK | Help

Slot 1 Port 4 Disabled

ioControl Settings
I// 4  System Info | EventLog | Host Access Groups | Long Running Tasks | Metwork Addressing | Metwork Services | Powe p | +
g8
p—— System Network Interfaces
%& Mame Stale Storage Processor Mode Address Speed
Management 1 Up B Static 172.16.0.16 1Gb | Edit |
S S—
gAY Management 2 Up B Static 192.168.100.200 1Gb |ﬂ|
““-“’._'_.f‘,— Slot 1 Port 1 Down B Disabled 1Gb |§|
i S—
( “\I Slot 1 Port 2 Down B Disabled 1Gb | Edit |
' Slot 1 Port 3 Disabled 1Gb | Edit |

Slot 2 Port 1 Up B Stafic | 192.168.0.102 10 Gb | Edit |

) —

Slot 2 Port 2 Up B static | 192.168.0.103 10 Gb | Edit |
."I. .’"

Management 1 Up A DHCP/ /[ 172.16.12.210 1Gb | Edit |

f f —

192.168.100.100  1Gb | Edit |

Management 2 Up A

Slot 1 Port 1

Slot 1 Port 2

Slot 1 Port 3

Slot 1 Port 4 Disabled

Slot 2 Port 1 Up A Static  _ 182.168.0.100 10 Gb | Edit |

s

-

g
Slot 2 Port 2 Up A Stg.li-f’ , 192.166.0.101
/ -
=

E&'FUEiON-iO

© 2013 Fusion-io, Inc

Figure 7: Locating system network interface and addresses with the ioControl Ul.
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Figure 8 shows where the specific network configuration occurs in the ioControl

User Interface.
Edit Metwork Interface Configuration

Modify Network Configuration

Storage Processor A
Name Slot 2 Port 1
Mode | Static

Address | 192.163.0.100 =/
E

Mask 2552552550

Gateway

Frame Size[ 2000

Default Gateway

MAC 00:25:90:c9:e8:95
Save Config Changes

Validate Configuration
Address

Frame Size 3000

Fing Address

Figure 8: Editing network interface configuration with ioControl Ul.

We then connected the four 10Gbps links to our Cisco Nexus 5010 Switches and
two 1Gbps RJ-45 uplinks to our management network.
Provisioning storage

ioControl hosted all workload VM datastores and we sized each virtual desktop
LUN as per VMware best practices.> We started by classifying our applications as
Mission-Critical, Business-Critical and Non-Critical based on ioControl QoS guaranteed
minimum IOPS, throughput, and not-to-exceed latency policy values. Based on a typical
mixed-workload business infrastructure, we assigned Microsoft SQL and 150 high-end
VDI users as Mission-Critical, Microsoft Exchange and 300 mid-range VDI users as
Business-Critical and remaining 150 VDI users as Non-Critical. We provisioned LUNs with

the ioControl GUI. See Figure 9 for detailed storage information.

3 www.vmware.com/files/pdf/view/Server-Storage-Sizing-Guide-Windows-7-TN.pdf
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RS |6 Host access Polic Hosting role Storage
Name (GB) y & processor
exchanse | 450 | eLsy Business-critical: 30,000 IOPS, 375 t‘;i:fne”e A
& MB/sec bandwidth, 20ms latency 8
Servers
Mission-critical: 75,000 IOPS, 750 OLTP SQL
DVD-5QL | 500 | cl-s7 MB/sec bandwidth, 10ms latency servers A
VDT-A 400 cl-s4, c1-s5, MISSIOH-CrItlca|.: 75,000 IOPS, 750 150 virtual B
cl-s6, c1-s8 | MB/sec bandwidth, 10ms latency desktops
VDT-B 400 c1-s4, c1-s5, | Business-critical: 39,000 I0OPS, 150 virtual B
cl-s6, c1-s8 | 375MB/Sec bandwidth, 20ms latency | desktops
VDT-C 400 c1-s4, c1-s5, | Business-critical: 39,000 I0OPS, 150 virtual B
cl-s6, c1-s8 | 375MB/Sec bandwidth, 20ms latency | desktops
VDT D 400 cl-s4, c1-s5, Non—cr!tlcal: 7,500 IOPS, 75MB/sec 150 virtual A
- c1-s6, c1-s8 | bandwidth, 100ms latency desktops
Test harness
NASO1 1TB | Infral-3 N/A datastore, N/A
generic NAS

Figure 9: Detailed storage configuration.

We configured LUNS, assigned QoS policies, and configured iSCSI access policies
in the ioControl Ul. Figure 10 shows LUN configuration with ioControl.

ioControl Provision

Mission Critical Business Critical MNon Critical
Policy 1 E el Policy 2 E o) Policy 4 Ee3
. DWVD-SQL, 500.00GE ' Exchange, 450.00GB . wDT-d, 400.00GB
. vDT-a, 400.00GE . vDT-b, 400.00GB Policy 5 [

. vDT-c, 400.00GE

Policy 3 e

Figure 10: Configuring LUNs with the ioControl Ul.

Figure 11 shows configured access groups with ioControl.
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ioControl Settings

4 | System Info | Ewvent Log | Host Access Groups | Long Running Tasks | Network Addressing | MNetwork Services | Powe p | =

System Host Access Groups

| Create New Host Access Group ]

1- 5 of 5 items 10 | 25 | 50 | 100 | AN 1

Mame

[Vewniap | s | [ et |
saL [ewmen) (Eox) (oeer]
[Vewniap | [Eat| [ et |
Allow Access View Map Edit Delete
Deny Access View Map Edit Delete

Figure 11: Configuring storage host access groups with ioControl UI.

Figure 12 shows how we configured initiators in a storage access group.

»
X

Modify Host Access Group

Group Name |DT hosts x
Initiator List ign.1998-01.com.vmware: |¥|
iqn_1998-01_com vmware: |§|
iqn._1998-01_com vmware: |§|
iqn.1993-01.com.vmware: |§|
| Aad nitator

|, Update Group |

L

Figure 12: ioControl GUI: Storage host access groups

Setting up the host network and storage adaptor

Each Cisco UCS B200 M3 server has two 20Gbps vNICs; one 20Gbps link is on
Fabric A and the other is connected to Fabric B. We set up a VMware VMKernel
interface on each fabric to ensure redundancy and multipathing across both fabrics. To
accomplish this, we needed to specify the override vSwitch setting and specifically bind
iSCSI-a to vNICO, and iSCSI-B to vNIC1. We set up Jumbo frames on both vNICs and
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tested connectivity. Figure 13 shows how we accessed the VMware host network

configuration with the UI.

View: |vSphere Standard Switch vSphere Distributed 5witch|

Networking
Standard Switch: vSwitchd Remove... Properties...
irbual Machinz Port Group — - Phiyzical Adaptars
2 public-net & o BB vmnicl 20000 Full §3
Virtual Machine Port Group i«.@ vmnicl 20000 Full G3
L3 priv-net Q_«w
VLAN ID: 100

VMkarnel Port
L1 mgmt-if @ o
vmk3 : 172.16.0.4 | VLAN ID: 100

WMkzrmeal Port

L iscsi-b ﬁn«w
ymk2 @ 192,168.0.69 | VLAN ID: 200
VMkarmel Port

[ iscsi-a ﬁ*ﬂ'

vmkl : 192.168.0.68 | VLAN ID: 200

Figure 13: Configuring VMware host network.

Figures 14 and 15 show where we configured the iSCSI settings.

|"__,J iscsi-a Properties

General | 1P Settings | Security | Traffic Shaping | NIC Teaming |

—Port Properties
MNetwork Label: Iiscsi—a
YLAN ID (Optional): |zun |
vMotion: ™ Enabled
Fault Tolerance Logging: ™ Enabled
Management Traffic: ™ Enabled
iSCSI Port Binding: ¥ Enzbled
—MIC Settings
MTL: IEII]DI] 3:

Figure 14: Configuring iSCSI-a with the VMKernel interface.
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ET,J iscsi-b Properties

General | IF Settings I Security I Traffic Shaping | MIC Teaming

—Port Properties
Metwork Label; Iiscsi-l:u
VLAN ID (Optional): |zn|:| |
vMotion: ™ Enabled
Fault Tolerance Logging: ™ Enabled
Management Traffic: ™ Enabled
i5CSI Port Binding: ¥ Enabled
—MIC Settings
MTL: I'EIEIEIEI 3:

Figure 15: Configuring iSCSI-b with the VMKernel interface.

Figure 16 and 17 show where to override NIC teaming for iSCSI-a and iSCSI-b.

|'E iscsi-a Properties E |

" General I IP Settings I Security I Traffic Shapin

—Policy Exceptions

Load Balancing: I IRc-ute based on the originating virtual port ID ;I
Metwork Failover Detection: - ||_i|-,p_ status only ;I
Motify Switches: I I'T'Es ;I
Failbacdk: I I'T'Es ;I

er Order:
( [+ ovylerride switch failover order:
active and standby adapters for this port group. In a failover situation, standby
adapters activate in the order specified below.

Marme | Speed | Metworks | Mave lp I
Active Adapters :

B9 vmnic0 20000 Full 10.41.2.1-10.41.2.254, 172.16.0.8... V9= Uiy
Standby Adapters

Unused Adapters

BR vmnict 20000 Full 10.41.2.1-10.41.2.254, 172.16.0.5...

Figure 16: Overriding NIC teaming for iSCSI-a.
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|"17,J iscsi-b Properties

General | IP Settings | Security | Traffic Shapi

— Policy Exceptions

Load Balancing:

r IRDutE based on the originating virtual port ID ll

Metwork Failover Detection: I ILink status only LI

Motify Switches: r I'T'Es ;I

Failback: I I'T'Es ll
er Order:

¥ oyerride switch failover order:

active and standby adapters for this port group. In a failover situation, standby
adapters activate in the order specified below,

Mame |Speed |Netw-:urk5 | Mowve Up |
Active Adapters :

EJ vmnicl 20000 Full 10.41.2.1-10.41.2.254, 172,16.0.8... Move Dove
Sstandby Adapters

Unused Adapters

BB vmnico 20000 Full 10.41.2.1-10.41.2.254, 172.16.0.8...

Figure 17: Overriding NIC teaming for iSCSI-b.

Figure 18 shows the VMKernel port bindings with the host iSCSI Initiator

interface.

|J-_-T,J i5CSI Initiator (wvmhba32) Properties

‘General Metwork Configuration |D1fnamic Discovery | Static Discovery |

WMkernel Port Bindings:
Part Group + | WMkernel Adapter | Port Group Palicy | Path Status
B iscsi-a(vSwitchd) vmkl & Compliant § Active
B  iscsi-b (vSwitchd) vmk2 @& Compliant @ Active
1| | i
Add... | Remove |
WiMkernel Port Binding Details:

Figure 18: Using the host iSCSI Initiator interface to confirm VMKernel port binding.
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Figure 19 shows how we discovered iSCSI targets with the host iSCSI Initiator.

|J--_T,J iSCSI Initiator (vmhba32) Properties

" General I Metwork Configuration  Dynamic Discovery | Static Discovery I
Send Targets
Discover i5CSI targets dynamically from the following locations (IPv4, IPvE, host name):

12251 Server Locatian |
192.168.0.100:3260
192.168.0.101:3260
192.168.0.102:3260
192.168.0.103:3260

Figure 19: Using the host iSCSI Initiator to discover ioControl targets.

Each LUN was attached to VMWare hosts. We changed the default path
selection from default fixed to round robin, enabling all four 10Gbps interfaces on the
array to be utilized. Figure 20 shows where to manage the paths in host datastore

properties with the VMKernel interface.

|J-_T,J Exchange Properties E1
Volume Properties
—General Format
Datastore Mame:  Exchange Rename... File System: VMFS 5.58
Total Capadty: 449,75 GB Increase... Sl Teie EELTE
_— Block Size: 1MB

—Storage IfO Control

" Enabled Advanced...
Extents Extent Device
A VWMFS file system can span multiple hard disk partitions, or The extent selected on the left resides on the LUM or physical
extents, to create a single logical volume. disk described below.
Extent | Capaciky | Device Capacity
NexGen iSCSIDisk (naa.6f49461705581384... 450.00 GB MexGen iSCSI Disk (naa.6f4946... 450.00 GB
Primary Partitions Capadity
1. VMF5 450.00 GB

Refresh Manage Paths...

Close I Help |

Figure 20: Managing paths in host datastore properties.
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|J-_-T,J NexGen iSCSI Disk (naa.6f494617055813880304d754cb12e8b7) Manage Paths

Figure 21 shows where to select the path setting.

Figure 21: Selecting the multipath policy in host datastore properties.

Setting up Fusion ioTurbine

—Palicy
Path Selection: IRound Robin (VMware) j hange
Storage Array Type: VMW _SATP_ALUA

—Paths
Runtime Mame Target LU | Status e | Preferred | -
vmhba32:C0:T1:L0  ign.2010-11.com.nexgenstorage:Exchange:b6de27840.. 0 & Active (If0) |
vmhba32:C1:T1:l0  ign.2010-1l.com.nexgenstorage:Exchange:b6de2784H-0.. 0 & Active (If0)
vmhba32:C6:T1:L0  ign.2010-11.com.nexgenstorage:Bxchange:b6de27840.. 0 @ Active (IfO)
vmhba32:C7:T1:l0  ign.2010-1l.com.nexgenstorage:Exchange:b6de2784-0.. 0 & Active (If0)
vmhba32:C2:T1:L0  ign.2010-11.com.nexgenstorage:Exchange:b6de27840.. 0 @ Active
vmhba32:C3:T1:L0  ign.2010-11.com.nexgenstorage:Bxchange:b6de27840.. 0 & Active
vmhba32:C4:T1:L0  ign.2010-11.com.nexgenstorage:Exchange:b6de27840.. 0 @ Active

Refresh

i,

Fusion ioTurbine has two components: the ioSphere management appliance and

a Fusion ioDrive2 mezzanine card. By using the PCl-e flash memory as a read cache,

ioTurbine enabled our solution to handle large I/O demands without taxing the shared

storage. The cache can be configured for the entire ESXi host or at the guest level. As

Figure 22 shows, we enabled the cache at the guest level and instructed it to cache only

the database volume (E:\) for each SQL server in our testing.

Infrastructure host

C1-S7

%

ioTurbine/ loSphere
management
appliance

Figure 22: ioTurbine overview.

ioTurbine
caching software
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We installed the ioDrive2 mezzanine card into server c1-s7, which was the SQL
and Exchange host. The ioTurbine management server is a virtual appliance that is
deployed on an infrastructure ESXi host and managed by vCenter. The management
server is deployed into the VMware environment as an OVA file. See Appendix C for
deploying ioSphere.

Figure 23 shows how to register vCenter in ioSphere.

T

VCENTER SERVER

Configure the vCenter server connection parameters.
APPLICATION

Server: e vCeNter
REMOTE ACCESS

Secure connection: ]
REMOTE ACCESS KEY

Username: sl domain\administrator
AGENTS

Password: m————l ssssssese

DATABASE

Register |

4 VCENTER SERVER

LABELS

SAVED SEARCHES

USERS
LOCAL ACCOUNTS

DENTITY PROVIDERS

Figure 23: Registering vCenter in ioSphere.

Figure 24 shows where to find the Fusion ioSphere tab in vCenter.

c1-s7.ibsen Jocal VMware ESXi, 5.1.0, 1612806

B [ veenter.ibsen local
= New Datacenter £
@ infra :Allocation ' Performance ' Configuration ' Tasks & Events ' Alarms ' Permissions ' Maps ' Storage Viiws irdwafe Status | Update Manager
Fflj taunchers
gl vo1
B [ [c1-s7.ibsen.local
th exchol
Gh exchoz
Gh excho3
Gh exchod c¢1-s7.ibsen.local
s sgio1
£ sqi02 c1-s7.ibsen.local
s sglo3 CONFIGURE

[ sqloa 1249D007C

IBESENVADMINISTRATOR | HELP

gal, s e

Update Host Software More Actions
»Basic
»Cache Manage Caching

sLicenses Add License

Figure 24: Locating the ioSphere tab for vCenter.
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Figures 25 and 26 show how we enacted a low-level format with Fusion

ioSphere.

Y Skl ere

c1-57

c1-s7.ibsen.local CONFIGURE

rs

1249D007C

Settings

iolMlemory Alias:
Device Status:

Swap Support:

Beacon:

~Firmware Update Firmware

VSL Driver Version:
Firmware Version:

1249D007C  Change
Attached Detach
Disabled

Off Enable

3.26
7.1.15 (110356)

vLow-Level Formatting Low-Level Reformat

Low Level Formatting:

Total Factory Capacity:

Format Capacity:

Sector Size:

Factory Capacity
785 GB (731.088 GiB)
100% factory capacity
785,000,000,000 bytes
512 bytes

Figure 25: Selecting the low level reformat option in ioSphere.

LOW-LEVEL FORMAT

(1 Device)

X CLOSE

FORMATTING

This option provides the factory capacity for the device.

|Fact0ry Capacity

SECTOR SIZE:

512bytes

DEVICES

Format | ioMemory PCI Address
1249D007C 81:00.0 785 GB

Figure 26: Performing a low-level format.

Current Formatting

Write Performance

Capacity
(100%)

New Formatting

785 GB (100%)

[ Format Devices } Cancel
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Figures 27 and 28 show how we enabled guest-based caching.

> AP oo S T

v CONFIGU

c¢1-s7.ibsen.local

c¢1-s7.ibsen.local CONFIGURE

1249D007C
Update Host Software ~ More Actions
¥ Basic
Host Name: c¢1-s7.ibsen.local
Agent Status: &9 Online

IP Address: 172.16.0.4
OS: VMkernel 5.1.0

v Caclfe Manage Caching

Figure 27: Locating the cache setings in vSphere.

Caching Version: 2.1.3.177

Select up to 8 cache devices:
[T]| Path Vendor Device Model Capacity

Amfsidevice.. Fusion-io Block device 785 GB
~mfsidevice.. DGC LUNZ 0GB
hmfsidevice... LS| MRSASRoMB-4i 208999 GB
hmfsidevice.. DGC VRAID 107.374 GB

]DDD@

Nmfs/device... MexGen TierStore 483184 GB v|
Total Capacity: 785 GB

Mumber of cache devices: 1
Select VMs to cache:
() Cache all VMs using host-based caching
et custom cache settings
Edit All Vs Edit reboot settings for all
Wi Caching Method Caching Selection Reboot Now
5qIUZ Guest-based ache All ] N
5ql03 Guest-based Cache All
exch03 Host-based Cache All MNIA
sql04 Guest-based Cache All
exch04 Host-based Cache All TIA
sql01 | v Cache All A
" No Caching =

Host-based
Guest-based Lancel

Figure 28: Choosing the correct options to enable guest-based caching.

Figure 29 shows where we entered guest credentials. This action is required to

enable guest-based caching.
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ENTER GUEST CREDENTIALS

Guest credentials are required to configure guest-based caching. These credentials will not be stored.

VM

5q/02
503
5q/04

5q/01

User Name Password

[administrator [ssssssess
[administrator [ssssssess
[administrator [ssssssess
[administrator [sessssssss

Cancel

Figure 29: Entering guest credentials to enable guest-based caching in ioSphere.

sqloz

Figure 30 shows where to change cache settings.

Summary | ResourceAllocation | Performance | Tasks &Events Alarms  Console | Permissions | Maps = Storage Virws u; date Manager

A e Aae

sqlo2

INFORMATION

vCache

Figure 30: Editing cache information in ioSphere.

Caching Status:

Guest Caching Priority:
Caching Selection:
Current Capacity:

Guest Software Version:

Enabled (Caching) Disable
Medium Change

Cache All
196.23 GB
213477 Update

Figure 31 shows how we changed the cache volume.
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CHANGE CACHING SELECTION X CLOSE

5gl02

Select items to cache:

(O Cache all volumes

Set custom cache settings

Volumes Disks Files

| Volume

CA49.66 GB NTFS
E\35.70 GB NTFS
L\ 44.30 GB NTFS

O m@E A

Cancel

Figure 31: Changing the cache volume in ioSphere.

Virtual machine architecture
We installed all of our VMs on a flat network. We installed all of our
infrastructure VMs on generic NAS and they were hosted on a separate infrastructure

server. Figure 32 shows detailed information of the VMs.

/ 44 / 4 [/ 4
H B E e

DC1 vCenter Composer
/ 4 / 4
E E view001 (x600)
View SQL
Infrastructure Virtual Desktops

v /4
E E (4 4
VSI_Share  LOI (x24) E E
/ 4 / 4
SQL(X4)  EXCH (x4)

LGCO1  DVDS-C (x2)

Test harness Applications

Figure 32: Detailed VM information and locations.
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VALIDATION AND TEST RESULTS

Test scenario 1 —ioControl supporting all application workloads

e SQL/OLTP: Medium—about 6,500 OPM

e LoadGen/Exchange profile: Outlook_200

e VDI: 600 users, boot storm and Login VSI Medium workload (with flash),
benchmark mode

Test scenario 1 showed that the four VDI servers and one ESXi server hosting
OLTP and Exchange workloads pushed I/0 requirements to burst over 20,000 IOPS and
sustained a peak of over 6,000 IOPS. Storage response time remained low in spite of the
demand placed on the array by the UCS Blade Intel E5-2690 processors. There was no
I/O contention detected between the three workloads as VSImax was not reached on
the virtual desktop workload, RPC latency was low on the Exchange workload, and
operations per minute (OPM) was consistent for our SQL workload. Figure 34 shows the

system total for read/write IOPS.

System total:
Read/write IOPS (10/sec)

25,000

o £ @

20,000 E 9 >

- 2} c

(] 46 oo

15,000 = 3 9
10,000

5,000 ’

0

0 = N0 N VW OO N 1N 0
S S S S8 8 S 8 o oo

0:51
0:55
0:58
1:01
1:04
1:07
1:10
1:13
1:16
1:19
1:23
1:26
1:29
1:32

Time (hours:minutes)

Figure 33: Test scenario 1: 1/0 footprint. The boot storm completed in about five
minutes.

Figure 34 shows the system total read/write response time.
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System Total:
Read/write response time (ms)

50
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Figure 34: In test scenario 1, /O response time remained low through all phases of
testing.

Figure 35 shows the overall average OPM. The SQL server was not in contention
for 1/0 and OPM remained flat throughout all testing.

OPM overall average

10,000
9,000 o £ =
8,000 2 9 >
& (V2) c
7,000 5 o &b
6,000 > S S
’ o
5,000
4,000
3,000
2,000
1,000
0
00 A I NO MOV ANWNOKO I ™NO MW N LW 0 < 0
O O 0O 0O 0O 000000000 ™ ™ o o o o o o o o o
Time (hours:minutes)

Figure 35: Test scenario 1: OLTP OPM.

Figure 36 shows the average Exchange RPC latency. At no point in testing did
RPC latency reflect I/O contention. Note: Microsoft guidance states that anything less

than 50ms is acceptable RPC latency.
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Average Exchange RPC latency

50
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Figure 36: Test scenario 1: LoadGen RPC latency.

Looking at IOPS and response time from within the ioControl interface shows
the additional IOPS being generated during VDI boot storm and the ability of the
ioControl QoS engine to manage I/O prioritization for all three service levels. Figure 37
shows the IOPS and Figure 38 shows the associated response times.
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System System Total IOPS Read + Write Last Hour 'l:l'

30,000 Warm up
='§ § 20,000 Boot storm
l—: 2 1000 Login Vs

- 0
- %:35 %40 545 %50 %55 10:00 10:05 10:10 10:15 10:20 10:25 -
Time {mins)
Max: 26507 Average: 4527 44 Average Block Size: 18.87 K Average Response Time: 2.53
System System Total IOPS Histogram Read + Write Last Hour 'l:l'
2,000
_ @
1= 5-3 1,000
[ S M—— ._-_-_—-
— ! w —- ] + ] o 3 T o hl_, w - [ N v
= = ® ® ® ® 3§ F5 & z 2 gz = =5 =5 z
Block Sizes
Max: 1145 Average Block Size: 1887 K
Service Level Mizsion Critical 10PS Read + Write Last Hour 'l:l'

20,000
U= § 0,000
I

- 0
- %35 3:40 545 350 HES 10:00 10:05 10:10 10:15 10:20 10:25 -
Time {ming)
Max: 10969 Average: 281524 Average Block Size: 22 20 K Average Response Time: 167
Service Level Business Critical 10FPS Read + Write Last Hour i:l'
20,000
- g 9
—E g 10,000
= 'E - -
- 9:35 5:40 545 50 55 10:00 10:05 10:10 10:15 10:20 10:25 -
Time {ming)
Max: 12545 Average: 1178 69 Average Block Size: 13.66 K Average Response Time: 625
Sernvice Level Mon Critical 10PS Read + Write Last Hour 'l:l'
6,000
Z g 40m
l—E S 2,000
- 0 lr.o. T
- %35 3:40 945 250 55 10:00 10:05 10:10 10:15 10:20 10:25 -
Time {mins)
Max: 5513 Average: 52958 Average Block Size: 12 49 K Average Response Time: 630
Figure 37: ioControl interface showing IOPS generated during testing.
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System ~ System Total ~ Response Time ~  Read + Write -~ Last Hour ~ ﬁ'
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Login VS|

toermn
Milliseconds
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9:35 9:40 9:45 9:50 9:55 10:00 10:05 10:10 10:15 10:20 10:25
- Time (mins)
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= 9:35 9:40 9:45 9:50 9:55 10:00 10:05 10:10 10:15 10:20 10:25
- Time (mins)
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= 0-
= 9:35 9:40 9:45 9:50 9:55 10:00 10:05 10:10 10:15 10:20 10:25
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Figure 38: ioControl interface showing response times during testing.
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Figure 39 shows Login VSI v4 output. At 600 users, VSImax was not reached. The
increase in response times was due to processor saturation. Figure 40 shows processor
utilization on host c1-s4 throughout the testing.

VEImax v4

16000 ~—— Average Response
= Maximum Response
Slmax v4 not reached. — Minimum Response

600 sessions ransuccessiully — /5] Index Lverage

VSlbase = 2859
WSImax v4 threshold = 5458
Stuck =0

12800 VSimaxv4 average = 4378 1

Response time, ms
b—-

V5| Threshold: 5459

55 | I | :

Il
/Sl Baseline: 2859 |l ilﬂm Ii ﬁiﬂ”i ﬁﬂ#a;i
viE

Active Sessions

Figure 39: Test scenario 1: Login VSI v4 output.

CPU Performance

44"?0.120144:40 PM 410/2014 5:00 PM 41072014 5220 PM 410/2014 5:40 PM 471072014 6:00 PM 410/2014 6:20 PM
Time
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Figure 40: C1-S4 VDI processor utilization throughout the test.
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Summary of test scenario 1

As evidenced by the test results outlined above, in spite of a heavy mixed
workload that taxed our infrastructure, ioControl demonstrated its ability to support
multiple high performance applications by utilizing real time data placement along with
QoS policies to guarantee predictable performance levels.

Test scenario 2 — Scaling performance with zero footprint with Cisco

UCS Fusion ioDrive 2 and Fusion ioTurbine for VMware
e SQL/OLTP: Heavy—35,000 to 40,000 OPM

e LoadGen/Exchange profile: Outlook_200

e VDI: 600 users, boot storm and login VSI medium workload (with flash),
benchmark mode

e joTurbine: Guest-based cache enabled

Test scenario 2 showed that, similar to test scenario 1, the four VDI servers and
one ESXi server hosting OLTP and Exchange workloads pushed 1/0 requirements to burst
over 20,000 IOPS and pushed a sustained peak of over 7,000 IOPS. The difference in this
test came when ioTurbine was enabled and serviced about 10,000 IOPS on average,
with bursts into the 15,000 IOPS range and allowing for an increase of 40,000 OPM.
Storage response time again remained low. There was no I/O contention detected
between the three workloads as VSImax was not reached on the virtual desktop
workload. RPC latency was low on the Exchange workload and OPM was consistent for

our SQL workload. Figure 41 shows the system total read/write IOPS for test scenario 2.
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Figure 41: Test scenario 2: 1/0 footprint. The boot storm completed in about five
minutes.

Figure 42 shows the read cache serviced as many as 17,000 read operations per
second (OPS).
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Figure 42: Test scenario 2: ioTurbine.

Figure 43 shows the system total read/write response time for test scenario 2.
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Figure 43: Test scenario 2: 1/0 footprint. The boot storm completed in about five minutes.

Figure 44 shows the OPM overall average in test scenario 2. The SQL workload

was not in contention for I/O and OPM remained flat throughout all testing.
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Figure 44: Test scenario 2: OLTP OPM.

Figure 45 shows the average Exchange RPC latency in test scenario 2. At no
point in testing did RPC latency reflect I/0O contention. Note: Microsoft guidance states

that anything less than 50ms is acceptable RPC latency.
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Figure 45: Test scenario 2: LoadGen RPC latency.

Looking at IOPS from within the ioControl interface shows only a minor increase
in Mission Critical IOPS serviced by ioControl, in addition to again demonstrating the 10
prioritization managed by the ioControl QoS engine (see Figure 46).
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Figure 46: ioControl interface showing IOPS generated during testing.
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Figure 47 shows the Login VSI v4 output. At 600 users, VSImax was not reached.
The increase in response times was due to processor saturation.
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Figure 47: Test scenario 2: Login VSI v4 output.

Summary of test scenario 2

As can be seen from the test results, utilizing the ioDrive2 and ioTurbine
software along with Fusion ioControl increased application performance while adding
no additional footprint to the reference architecture. This resulted in a SQL OPM
increase over six times the OPM from test scenario 1 with no performance degradation,
while at the same time resulting in only a small increase in ioControl Mission-critical
array |OPS.

Using the ioControl user interface

The ioControl Ul let us view and record both real time and historical statistics on
the ioControl appliance throughout all testing. We could view statistics as they pertain
to QoS policy, storage processor, or the latency on SAS disk drives versus flash memory.
Figure 48 shows the main dashboard, which provides an overview of the state of the

appliance, and Figure 49 provides a view into the monitoring interface.
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Figure 49: ioControl Monitoring.
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SUMMING IT ALL UP

In our testing, Fusion ioControl, Cisco UCS, and VMware technologies created a
high-performance, easy-to-configure and manage solution that could handle a
demanding mixed application environment consisting of common virtualized business
applications and VDI. By prioritizing performance resources with ioControl QoS service
levels and policies, we demonstrated that mission-critical and business-critical
applications will run at optimum performance levels in a 600 virtual desktop boot storm,
or an OLTP heavy-workload use case. By adding Fusion ioTurbine software and Cisco
Fusion ioDrive2 into the UCS Blade Server, we further extended OLTP performance with
no additional solution footprint. With the Fusion ioControl Ul and ioSphere Ul
integration with vCenter Server, you can manage all aspects of storage, both ioControl
and UCS-side Fusion ioDrive flash, from within vCenter console. Fusion ioControl Hybrid
Storage and Cisco UCS is a strong solution to meet today’s demanding mixed workloads
in your VMware virtualized data center.
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APPENDIX A — DETAILED SYSTEM CONFIGURATION

Figure 50 shows the detailed information of the servers we used in testing.

System Cisco UCS B200 M3 server Cisco UCS B200 M2 server
General

Number of processor packages 2 2

Number of cores per processor 8 6

Number of hardware threads per ) 5

core

System power management policy OS Control OS Control

CPUs

Vendor Intel Intel

Name Xeon Xeon

Model number E5-2690 X5670

Stepping 6 co

Socket type LGA2011 LGA 1366

Core frequency (GHz) 2.90 2.93

Bus frequency 8.0GT/s 6.4

L1 cache 32 KB +32KB 32 KB+ 32 KB (per core)
L2 cache 256 KB (per core) 256 KB (per core)

L3 cache 20 MB 12 MB

Platform

Vendor and model number

Cisco UCS B200 M3

Cisco UCS B200 M2 Blade Server

Motherboard model number

Cisco FCH153271DA

N20-B6625-1

BIOS name and version

Cisco
B200M3.2.1.1a.0.121720121447

Cisco $5500.2.1.1.0.1005201213338

BIOS settings Default Default
Memory module(s)
Total RAM in system (GB) 256 96

Vendor and model number

Samsung M393B2G70BHO-YKO

Samsung M393B5170FHO-YH9

Type

PC3L-12800R

DDR3 PC3-10600

Speed (MHz) 1,600 1,333

Speed running in the system (MHz) 1,333 1,333

Size (GB) 16 8

Number of RAM module(s) 16 12

Chip organization Double-sided Double-sided
Rank Dual Dual

Hard disk

Vendor and model number Seagate ST9146803SS Seagate ST9146803SS
Number of disks in system 2 2

Size (GB) 146 146

RPM 15,000 10,000

Type SAS SAS
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System

Cisco UCS B200 M3 server

Cisco UCS B200 M2 server

RAID controller

Vendor and model

LSI MegaRAID SAS 2004

LSI Logic® SAS 1064E

Controller firmware

20.10.1-0100

01.32.04.00

Operating system

Name VMware vSphere 5 VMware ESXi 5.1 | VMware vSphere 5.1
Build number 1612806 1612806
Language English English

Operating system power profile

Maximum Performance

Maximum Performance

Adaptor(s)

Vendor and model number

Cisco UCSB-MLOM-40G-01

UCS M71KR-Q Qlogic® Converged

Network Adapter
Type mLOM mLOM
Vendor and model number Fusion 10 iodrive2, 768 GB N/A
Type Mezzanine N/A

Figure 50: Detailed configuration information for the servers.

Figure 51 shows detailed information for the storage we used in testing.

Storage array Fusion ioControl n5-150 array
Firmware revision

Model Fusion-io n5-150

Part Number XN50-2448-11E
ioMemory Capacity 2400 GB

Storage Processors Dual Active-Active
RAM 48 GB

Network Interfaces Data (4) 10GbE + (8) 1 GbE, Management : (4) 1GbE
Storage Protocol iSCSI

Management HTTP

Power 11.5 AMP

Dimensions 5.2"x17.2" x 25.5"
Weight 75 lbs

Tray 1

Number of disks 16

Disk vendor and model number Toshiba MG0O3SCA300
Disk size (GB) 37TB

Disk buffer size (MB) 64

Disk RPM 7200

Disk type SAS-2, 6 Gbps
Firmware revision 0108 Rev al
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Storage array

Fusion ioControl n5-150 array

PCle card ioDrive Il
Model Fusion ioDrive Il
Interface PCle

Figure 51: Detailed configuration information for the storage array.
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APPENDIX B—- METHODOLOGY FOR TESTING INFRASTRUCTURE

We prepared our UCS manager, servers, and server adaptors with firmware version 2.2(1b) and deployed all
blades with Cisco UCS service profiles. We configured each profile with one vNIC per fabric, and Raid 1 for local disk
policy. We installed ESXi 5.1 on each of the three infrastructure servers and the five servers under test.

Installing VMware ESXi 5.1 on the infrastructure servers and servers under test

Attach to the UCS server via KVM and attach the installation media.
Boot the server.
At the VMware Installer screen, press Enter.
At the EULA screen, press F11 to Accept and Continue.
Under Storage Devices, select the appropriate virtual disk, and press Enter.
Select US as the keyboard layout, and press Enter.
Enter the root password twice, and press Enter.
Press F11 to start installation.
After the server reboots, press F2 and enter root credentials.
. Select Configure Management Network, and press enter.
. Select the appropriate network adapter, and select OK.
. Log in to the server using the VMware vSphere client.
. Select the Configuration tab, and click Networking.
. Click Add Networking...
. Create the management network on VLAN 10.
. Click on the Configuration tab, and select Time configuration to configure server time.
. Click DNS and Routing, and confirm the settings.
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Setting up a VM to host the Microsoft Windows Active Directory® server (DC1)

Connect to the infral server via the VMware vSphere client.
Login as root
In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
Choose Custom, and click Next.
Assign the name DC1 to the virtual machine, and click Next.
Select infral as the host, and click Next.
Select the appropriate storage, and click Next.
Choose Virtual Machine Version 9, and click Next.
Choose Windows, choose Microsoft Windows Server® 2008 R2 (64-bit), and click Next.
. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.
. Choose 4 GB RAM, and click Next.
. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET network, and click Next.
. Leave the default virtual storage controller, and click Next.
. Choose to create a new virtual disk, and click Next.
. Make the OS virtual disk size 100 GB, choose thin-provisioned lazy zeroed, specify external storage, and click
Next.
16. Keep the default virtual device node (0:0), and click Next.
17. Click Finish.
18. Right-click the VM, and choose Edit Settings.
19. Click the Resources tab, and click Memory.
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20. Select Reserve all guest memory, and click OK.
21. Connect the VM virtual CD-ROM to the Microsoft Windows Server 2008 R2 installation disk.
22. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

Open a virtual machine console on DC1.
Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.
Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.
Click Custom.
Click the Disk, and click Drive options (advanced).
Click New—>Apply—>Format, and click Next.
After the installation completes, click OK to set the Administrator password.
. Enter the administrator password twice, and click OK.
. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
12. Reboot the server.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to DC1, and reboot when the installation prompts you.
16. Set up networking for the data network:
a. Click Start=>Control Panel, right-click Network Connections, and choose Open.
Right-click the VM traffic NIC, and choose Properties.
Uncheck TCP/IP (v6).
Select TCP/IP (v4), and choose Properties.
Set the IP addressas 172.16.0.10/255.255.0.0

Installing Active Directory and DNS services on DC1

1. Click Start>Run, type dcpromo, and click OK.

2. At the Active Directory Domain Services Installation Wizard welcome screen, check the Use advanced mode
installation option, and click Next.

3. Inthe Choose a Deployment Configuration dialog box, select Create a new domain in a new forest, and click
Next.

4. Atthe FQDN page, type domain. local, and click Next.

5. At the NetBIOS name prompt, leave the name domain, and click Next.

6. Atthe Forest Functionality level, select Windows Server 2008 R2, and click Next.
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At the additional Domain Controller Options, leave DNS server selected, and click Next.
Assign a Directory Services Restore Mode Administrator account password, and click Next.
. At the Summary screen, review your selections, and click Next.
10. Once Active Directory Domain Services finishes installing, click Finish, and restart the system.
11. Click Start->Run, and type dnsmgmt .msc
12. Create a reverse lookup zone for DC1.
13. Create static entries for the three infrastructure servers and the five servers under test.

Configuring the Windows time service on DC1
To ensure reliable time, we pointed our Active Directory server to a physical NTP server.

1. Openacommand prompt.
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2. Type the following:
W32tm /config /syncfromflags:manual /manualpeerlist:"<ip address of a NTP

server>"

W32tm /config /reliable:yes
W32tm /config /update
W32tm /resync

Net stop w32time

Net start w32time

Setting up DHCP services on DC1

1. Click Start->Administrative Tools—>Server Manager—>Add Roles.
Select DHCP Server, and click Next.
At the Introduction to DHCP Server screen, click Next.
At the Specify IPv4 DNS Settings screen, type domain. local for the parent domain.
Enter the preferred DNS server IPv4 address, and click Next.
At the Specify IPv4 WINS Server Settings screen, select WINS is not required for applications on the network, and
click Next.
At the Add or Edit DHCP Scopes screen, click Add.
At the Add Scope screen, enter the Name DHCP Scope name.
9. Inthe next box, set the following values, and click OK.
e Start IPaddress=172.16.2.1
e End IP address=172.16.100.200
e Subnet mask=255.255.0.0
10. Check Activate This Scope.
11. At the Add or Edit DHCP Scopes screen, click Next.
12. Click Enable DHCP v6 Stateless Mode, and click Next.
13. Leave the default IPv6 DNS Settings, and click Next.
14. At the Authorize DHCP server dialog box, select Use current credentials.
15. At the Confirm Installation Selections screen, click Next. If the installation is set up correctly, a screen displays
saying the DHCP server install succeeded.
16. Click Close.

Setting up a VM to host the vCenter server (vCenter)
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1. Loginto the infral server with the VMware vSphere client.
2. Inthe VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
3. Choose Custom, and click Next.
4. Assign the name vCenter to the virtual machine, and click Next.
5. Select infral as the host, and click Next.
6. Select the appropriate storage, and click Next.
7. Choose Virtual Machine Version 8, and click Next.
8. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
9. For CPUs, select one virtual processor socket, and four cores per virtual socket, and click Next.
10. Choose 8GB RAM, and click Next.
11. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET port group, and click Next.
12. Leave the default virtual storage controller, and click Next.
13. Keep the default virtual device node (0:0), and click Next.
Fusion-io Virtualization Reference Architecture: A Principled Technologies reference architecture 49

Deploying Server and Desktop Virtualization on
Fusion ioControl Hybrid Storage, Cisco UCS, and VMware



14. Connect the VM virtual CD-ROM to the Microsoft Windows 2008 R2 installation disk.
15. Click Finish.
16. Right-click the vCenter VM, and click Edit settings.
17. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.
18. Start the VM.
Installing the Microsoft Windows Server 2008 R2 operating system on the VM

=

Open a virtual machine console on vCenter.
Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.
Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.
Click Custom.
Click the Disk, and click Drive options (advanced).
Click New—=>Apply—> Format, and click Next.
After the installation completes, click OK to set the Administrator password.
. Enter the administrator password twice, and click OK.
. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
12. Reboot.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to vCenter, and reboot when the installation prompts you.
16. Set up networking for the data network:
Click Start, Control Panel, right-click Network Connections, and choose Open.
Right-click the VM traffic NIC, and choose Properties.
Uncheck TCP/IP (v6).
Select TCP/IP (v4), and choose Properties.
. Set the IP address, subnet, gateway, and DNS server.
17. Join the domain.local domain.
18. Reboot the system.

Setting up a VM to host Microsoft SQL server (SQL) for infrastructure
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1. Connect to the infral server via the VMware vSphere client.
2. Loginas root
3. Inthe VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
4, Choose Custom, and click Next.
5. Assign the name SQL to the virtual machine, and click Next.
6. Select infral as the host, and click Next.
7. Select the appropriate storage, and click Next.
8. Choose Virtual Machine Version 9, and click Next.
9. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
10. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.
11. Choose 4 GB RAM, and click Next.
12. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET network, and click Next.
13. Leave the default virtual storage controller, and click Next.
14. Choose to create a new virtual disk, and click Next.
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15. Make the OS virtual disk size 100 GB, choose thin-provisioned lazy zeroed, specify external storage, and click
Next.

16. Keep the default virtual device node (0:0), and click Next.

17. Click Finish.

18. Right-click the VM, and choose Edit Settings.

19. Click the Resources tab, and click Memory.

20. Select Reserve all guest memory, and click OK.

21. Connect the VM virtual CD-ROM to the Microsoft Windows Server 2008 R2 installation disk.

22. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

Open a virtual machine console on SQL.
Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.
Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.
Click Custom.
Click the Disk, and click Drive options (advanced).
Click New—=>Apply—>Format, and click Next.
After the installation completes, click OK to set the Administrator password.
. Enter the administrator password twice, and click OK.
. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
12. Reboot the server.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to SQI, and reboot when the installation prompts you.
16. Set up networking for the data network:
a. Click Start=>Control Panel, right-click Network Connections, and choose Open.
Right-click the VM traffic NIC, and choose Properties.
Uncheck TCP/IP (v6).
Select TCP/IP (v4), and choose Properties.
Set the IP address, subnet, gateway, and DNS server.
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Installing Microsoft SQL Server 2008 R2

1. Insert the installation media, and click OK to install .NET framework.

2. Wait for the SQL Installer to launch. On the left menu, click Installation.

3. Click New installation or add features to an existing installation. Click OK.

4. Enter the Product Key, and click Next.

5. Check the I accept the license terms checkbox, and click Next.

6. Click Install to install the Setup Support Files (required).

7. Resolve any issues displayed in the setup wizard, and click Next.

8. Atthe Setup Role screen, select SQL Server Feature Installation, and click Next.

9. Select Database Engine Services, Full-Text Search, Client tools Backwards Compatibility, Management Tools Basic

and Complete, and click Next twice.
10. Accept instance configuration defaults, and click Next.
11. Accept defaults for disk space requirements, and click Next.
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12. Click Use the same account for all SQL Server services, select NT Authority\System, and click OK. Click Next.
13. Select Mixed Mode, and enter a password for the SA account. Click Add Current User, and click Next.
14. Accept defaults for error reporting, and click Next.
15. Review installation configuration rules check, and click Next.
16. To begin the installation, click Install.
17. At the completion screen, click Close.
18. Run Windows Update to receive all updates and security patches.
Setting up databases for vCenter and VMware View™ Composer

1. LogontoSQLas DOMAIN\administrator

2. From the server desktop, open Start=>All Programs—>Microsoft SQL Server 2008 R2-> Configuration Tools=>SQL

Server Configuration Manager.

Click SQL Server Network Configuration—>Protocols for MSSQLSERVER.

Right-click TCP/IP, and select Enabled.

Click SQL Services—>right-click SQL Server Browser, and select Properties.

In the SQL Server Browser Properties, select the Services tab, change the Start mode to Automatic, and click OK.

Repeat this step for the SQL Server Agent service.

Start the SQL Server browser service and the SQL Server Agent service.

8. From the SQL server desktop, open Start=>All Programs—>Microsoft SQL Server 2008 R2-> Configuration
Tools=>SQL Server Management Studio.

9. Click Connect.

10. Select the Databases folder, right-click, and select New Database.

11. Provide the name vCenter for the new database.

12. Select the Databases folder, right-click, and select New Database.

13. Provide the name composer for the new database.

14. Click Options, change the recovery model from full to simple, and click OK.
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Setting up an ODBC DSN on vCenter

=

Log in to vCenter as DOMAIN\administrator

Click Options and change the recovery model from full to simple, and click OK.

From the desktop of the vCenter server, select Start, Run, and type odbcad32.exe. Press Enter.

Click the system DSN tab.

Click Add.

Click SQL Server Native Client 10.0, and click Finish.

In the Create a New Data Source to SQL Server text box, type the connection name vcenter

For Server, select SQL, and click Next.

Change authentication to With SQL Server authentication using a login ID and password entered by the user,
type sa as the Login ID, use the password you defined in SQL server setup for the SA account, and click Next.
10. Select Change the default database to choose vCenter from the pull-down menu, and click Next.

11. Click Finish.

12. Click Test Data Source... to confirm correct configuration.

13. Click OK to create the vCenter ODBC connection.
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Installing VMware vCenter 5.1

1. LogontovCenter as DOMAIN\administrator
2. From the VMware vCenter 5.1 install media, click Autorun.
3. Click Run to start the install wizard.
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10.
11.
12.
13.
14,
15.
16.
17.

18.

19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.
32.

Click the Install button on the VMware vSphere 5.1 Simple Install wizard.

Select the Install wizard language as English, and click OK.

At the Install wizard welcome screen, click Next.

At the End User Patent Agreement, click Next.

Agree to the License Agreement, and click Next.

Enter and confirm the password you wish to use with the Administrator account for vCenter Single Sign On, and
click Next.

Select Install a local Microsoft SQL Server 2008 R2 Express Instance, and click Next.

Enter and confirm the passwords for the DBA and SQL user accounts, and click Next.

Confirm the Fully Qualified Domain Name or IP address is correct, and click Next.

Check the Use network service account checkbox, and click Next.

Accept the default installation path, and click Next.

Accept the default https port, and click Next.

Click Install.

After Single Sign On completes, and vCenter Server installation begins, enter user information and a license key,
and click Next.

Select Use an existing supported database, and select the Data Source Name (DSN) for the connection to the
SQL Server: vcenter

Type sa as the database username, provide the password for the SA account, and click Next.
Select the system account for the vCenter Server service account, and click Next.

Keep the vCenter default ports, and click Next.

Select 1024 MB for the JVM memory, and click Next.

Click Install to finish the vCenter server installation.

Click Finish to exit the wizard.

Click OK to confirm completion.

Click Exit on the installer.

Restart the server.

Using the vSphere client, log in to the vCenter server as DOMAIN\administrator
Right-click the root of vCenter, and click New Data center.

Name the new data center datacenter

Add the infral-3 servers to the data center.

Upgrade DC1, vCenter, and SQL to VMware hardware ver 10

Setting up a VM to host VMWare View Composer

1. Login to the vCenter via the VMWare Web client.
2. Click the Virtual Machines tab.
3. Right-click, and choose New Virtual Machine.
4. Select Create a new virtual machine.
5. Choose Custom, and click Next.
6. Assign the name composer to the virtual machine, and click Next.
7. Select infral as the host, and click Next.
8. Select the appropriate storage, and click Next.
9. Choose Virtual Machine Version 9, and click Next.
10. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
11. For CPUs, select one virtual processor socket, and four cores per virtual socket, and click Next.
12. Choose 8GB RAM, and click Next.
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13. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET port group, and click Next.
14. Leave the default virtual storage controller, and click Next.

15. Keep the default virtual device node (0:0), and click Next.

16. Connect the VM virtual CD-ROM to the Microsoft Windows 2008 R2 installation disk.

17. Click Finish.

18. Right-click the composer VM, and click Edit settings.

19. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.
20. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

=

Open a virtual machine console on the composer VM.
Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.
Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.
Click Custom.
Click the Disk, and click Drive options (advanced).
Click New—>Apply—>Format, and click Next.
After the installation completes, click OK to set the Administrator password.
. Enter the administrator password twice, and click OK.
. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
12. Reboot.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to composer, and reboot when the installation prompts you.
16. Set up networking for the data network:
Click Start, Control Panel, right-click Network Connections, and choose Open.
Right-click the VM traffic NIC, and choose Properties.
Uncheck TCP/IP (v6).
Select TCP/IP (v4), and choose Properties.
Set the IP address, subnet, gateway, and DNS server.
17. Jom the domain.local domain.
18. Reboot the system.
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Setting up a database and ODBC DSN for VMware View Composer

1. Logon tothe composer VM as DOMAIN\administrator

From the desktop of the vCenter server, select Start, Run, and type odbcad32 .exe. Press Enter.

Click the system DSN tab.

Click Add.

Click SQL Server Native Client 10.0, and click Finish.

In the Create a New Data Source to SQL Server text box, type the connection name composer

For Server, select SQL, and click Next.

Change authentication to With SQL Server authentication using a login ID and password entered by the user,
type sa as the Login ID, use the password you defined in SQL server setup for the SA account, and click Next.
9. Select Change the default database to:, choose composer from the pull-down menu, and click Next.

10. Click Finish.
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11. Click Test Data Source... to confirm correct configuration.
12. Click OK to create the Composer ODBC connection.

Setting up VMware Horizon View Composer 5.3

1. Open the View 5 media folder, and run the file named VMware-viewcomposer-5.3.0

At the Welcome screen and the Patents screen, click Next.

Accept the VMware end user license agreement, and click Next.

Leave the Destination folder as default, and click Next.

In the Database information box, type composer as the source name and sa as the user name. Enter the
password, and click Next.

6. Leave the default SOAP port, and click Next.

7. Click Install, and click Finish.

8. Restart the server.

Setting up a VM to host the VMware View connection server

AW

1. Login to the vCenter via the VMWare Web client.

2. Click the Virtual Machines tab.

3. Right-click, and choose New Virtual Machine.

4. Select Create a new virtual machine.

5. Choose Custom, and click Next.

6. Assign the name View to the virtual machine, and click Next.

7. Select infrastructure for the host, and click Next.

8. Select the appropriate storage, and click Next.

9. Choose Virtual Machine Version 9, and click Next.

10. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.

11. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.
12. Choose 4GB RAM, and click Next.

13. Click 1 for the number of NICs, select VMXNET 3, connect to the PRIV-NET port group, and click Next.
13. Leave the default virtual storage controller, and click Next.

14. Choose to create a new virtual disk, and click Next.
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. Make the OS virtual disk size 100 GB, choose thick-provisioned lazy zeroed, specify the OS datastore on the
external storage, and click Next.

15. Keep the default virtual device node (0:0), and click Next.

16. Connect the VM virtual CD-ROM to the Microsoft Windows Server 2008 R2 installation disk.

17. Right-click the View Connection VM, and click Edit settings.

18. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.

19. Click Finish.

20. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

1. Open avirtual machine console on the View VM.

Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.

Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.

Click Custom.

Click the Disk, and click Drive options (advanced).

Click New—>Apply—>Format, and click Next.
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9. After the installation completes, click OK to set the Administrator password.

10. Enter the administrator password twice, and click OK.

11. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.

12. Reboot.

13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.

14. Enable remote desktop access.

15. Change the hostname to View, and reboot when the installation prompts you.

16. Set up networking for the data network:

Click Start, Control Panel, right-click Network Connections, and choose Open.

Right-click the VM traffic NIC, and choose Properties.

Uncheck TCP/IP (v6).

Select TCP/IP (v4), and choose Properties.

. Set the IP address, subnet, gateway, and DNS server.

17. Join the VDI domain.

18. Reboot the system.
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Installing the VMware View Connection Server 5.3

1. Login to the server named View Connection.

2. Browse to VMware View installation media, and click VMware-viewconnectionserver-x86_64-5.3.0
3. Click Run.

4, At the Welcome screen, click Next.

5. Agree to the End User License Agreement, and click Next.

6. Keep the default installation directory, and click Next.

7. Select View Standard Server, and click Next.

8. At the Data Recovery screen, enter a backup password, and click Next.

9. Allow View Server to configure the Windows firewall automatically, and click Next.

10. Authorize the local administrator to administer View, and click Next.

11. Choose whether to participate in the customer experience improvement program, and click Next.
12. Complete the installation wizard to finish installing View Connection Server.

13. Click Finish.

14. Reboot server.
Configuring the VMware Horizon View Connection Server

1. OpenaWeb browserto <view connection server FQDN>/admin
2. loginasadministrator
3. Under Licensing, click Edit License...
4. Enter avalid license serial number, and click OK.
5. Open View Configuration—>Servers.
6. Inthe vCenter Servers tab, click Add...
7. Enter vCenter server credentials, and click Next.
8. Atthe View composer screen, select View Composer co-installed with vCenter Server, and click Next.
9. Atthe View composer domains screen, click Add...
10. Enter full domain name and user credentials.
11. At the storage screen select Reclaim VM disk space, and Enable View Storage Accelerator.
12. Change the Default host cache size to 1024 MB, and click Next.
13. At the ready to complete screen, click Finish.
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Setting up a Windows 7 Enterprise (x86) ESXi base image VM

1. Login to the vCenter via the VMWare Web client.

2. Click the Virtual Machines tab.

3. Right-click, and choose New Virtual Machine.

4. Select Create a new virtual machine.

5. Choose Custom, and click Next.

6. Assign the name View—-gold, and click Next.

7. Select the c1-s8 host, and click Next.

8. Select the appropriate storage.

9. Choose Virtual Machine Version 9, and click Next.

10. Choose Windows, choose Microsoft Windows 7 (64-bit), and click Next.

11. For CPUs, select one virtual processor socket and two core per virtual socket, and click Next.

12. Choose 1 GB RAM, and click Next.

13. Click 1 for the number of NICs, select VMXNET 3, and click Next.

14. Leave the default virtual storage controller, and click Next.

15. Choose to create a new virtual disk, and click Next.

16. Make the OS virtual disk size 24 GB, choose Thin Provision, specify the OS datastore on the external storage, and
click Next.

17. Keep the default virtual device node (0:0), and click Next.

18. Click Finish.

19. Click the Resources tab, click Memory, and check the Reserve all guest memory checkbox.

20. Click the Hardware tab, CD/DVD Drive, and Connect the VM virtual CD-ROM to the Microsoft Windows 7 x64
installation disk.

21. Click OK.

Installing Windows 7 Enterprise (x86) on ESXi base image VM

=

When the installation prompts you, press any key to begin setup.
Enter your language preferences, and click Next.
Click Install.
Accept the license terms, and click Next.
Select Custom, and select the drive that will contain the OS.
Click Install.
Type user for the username, and click Next.
Enter no password, and click Next.
At the system protection screen, select Use recommended settings, and click Next.
. Enter your time zone, and click Next.
. Select the Work Network setting, and click Next.
. Install VMware Tools, and select Complete Installation. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
13. Reboot.
14. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
15. Join the domain and restart the VM.
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Installing the VMware Horizon View 5 agent

1. Browse to the VMware Horizon View 5 media, and run the VMware-viewagent file.
2. Click Run.

3. Atthe Welcome screen, click Next.

4. Accept the VMware end user license agreement, and click Next.
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5. Select defaults, and click Next.
6. Enter the server name of the View Connection Server, and click Next.
7. Click Install.

Configuring Regedit for QuickPrep

1. Click Start>Run, and type regedit

2. Browse to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\vmware-viewcomposer-ga.
3. Right-click SkipLicenseActivation, and click Modify...

4. Change the value from 0 to 1.

5. Shut down the machine, and take a snapshot of the final disk image.

Deploying Virtual Desktops using VMware Horizon View.

1. Open the View Administrator.

2. loginasadministrator

3. Under Inventory click Pools, and then click Add...

4. Select Automatic Pool, and click Next.

5. Select Dedicated, and click Next.

6. Select View Composer linked clones, and click Next.

7. Type pool for the pool ID and display name, and click Next.

8. Leave the pool settings as defaults, and click Next.

9. Under Naming Pattern, enter an appropriate name pattern for the pool.

10. Under Pool Sizing, type 1 for Max number of desktops and the number of spare (power on) desktops.
11. Select provision all desktops up-front, and click Next.

12. Under persistent disk, change the disk size to 2048.

13. Select Redirect disposable files to a non-persistent disk, type 4096 MB for Disk Size, and click Next.
14. Under Storage Optimization, click Next.

15. Under vCenter Settings, use:

e Parent VM: <name of parent vm>
VM folder:
e Host or cluster: /c1-s8/
e Resource pool: /cl-s8/
e Datastores= vDT-D , Overcommit: Aggressive
16. Under Advanced Storage Options, select Use View Storage Accelerator (OS disk, 7 days).
17. Under Guest customization, select the following:
e Domain: domain.local
e AD container: CN=Computers
o Select Use Quick Prep, and click Next.

18. Click Finish.
19. Repeat 15-18 to create four groups of 150 desktops on each of the VDT hosts/storage:
Cl1-s4,vDT-D
cl-s5, VDT-C
cl-s6, VDT-B
cl-s8, VDT-A
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Installing the Login VSI 4 benchmark

Setting up a VM to host the Login VSI share
1. Connect to an infrastructure server via the VMware web client.

2. Inthe VMware vSphere client, under Basic Tasks, select Create a new virtual machine.

3. Choose Custom, and click Next.

4. Assignthe name VSI share to the virtual machine, and click Next.

5. Select infral as the host, and click Next.

6. Select the appropriate storage, and click Next.

7. Choose Virtual Machine Version 9, and click Next.

8. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.

9. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.

10. Choose 4 GB RAM, and click Next.

11. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET network, and click Next.

12. Leave the default virtual storage controller, and click Next.

13. Choose to create a new virtual disk, and click Next.

14. Make the OS virtual disk size 100 GB, choose thin-provisioned lazy zeroed, specify external storage, and click
Next.

15. Keep the default virtual device node (0:0), and click Next.

16. Click Finish.

17. Right-click the VM, and choose Edit Settings.

18. Click the Resources tab, and click Memory.

19. Select Reserve all guest memory, and click OK.

20. Connect the VM virtual CD-ROM to the Microsoft Windows Server 2008 R2 installation disk.
21. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM
1. Open avirtual machine console on VSlshare.
Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.
Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.
Click Custom.
Click the Disk, and click Drive options (advanced).
Click New—>Apply—>Format, and click Next.
After the installation completes, click OK to set the Administrator password.
. Enter the administrator password twice, and click OK.
. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
12. Reboot the server.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to VSIShare, and reboot when the installation prompts you.
16. Set up networking for the data network:
a. Click Start=>Control Panel, right-click Network Connections, and choose Open.
b. Right-click the VM traffic NIC, and choose Properties.
c. Uncheck TCP/IP (v6).
d. Select TCP/IP (v4), and choose Properties.
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e. Setthe IP address, subnet, gateway, and DNS server.

Installing the Login VSI benchmark on VSI_share
1. Loginto VSI_Share.
Create a folder named c: \share
Right-click the c:\share folder, and click Properties.
Click the Sharing tab, and click Share...
Add everyone, system, and administrators to the Read/Write group, and click Share.
Unpack the Login VSI install media.
Open Datacenter setup\setup.exe.
At the welcome screen, click Next.
Select the share named \\vsishare\share, and click Next.
. Check the Start Login VSI Management Console checkbox to start the Management Console when the setup is
completed, and click Finish.
11. At the management console enter the path to your login VSl license file and click save.
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Configuring Login VSI: AD setup
1. Open the VSI management console and click “1. AD setup”
2. Enter the following

Base OU DC=domain, DC=local
Username LoginVSI

Passwordl * )k k ok k Kk k kK

Domain (auto detect checked)
Number of users 600

Formatting length 1

Launcher user Launcher-v4

Launcher password * ok ok ok ok ok ok kK ok

Click save to .spl
3. Copy the VSIADSetup.ps1 file to \\DC1\c$
4. Login to DC1, and execute the VSIADSetup.psl in Windows PowerShell™.

Creating Windows 7 Enterprise x64 image VSI Launchers
Using the vSphere client, we created a Windows 7 Enterprise x64 VM with 2 vCPUs and 12 GB of memory.

Installing VMware View Client on the launcher
1. Accept the VMware license terms.
2. Select default options.
3. Accept or change the destination folder.
4. Click on Install.

Installing Virtual Audio Cable

By default, the virtual launchers cannot render audio, so we installed Virtual Audio Cable version 4.10 from

software.muzychenko.net/eng/vac.htm.

1. Download and extract the media.

2. Click Setup.
3. Click Yes to begin the install.
4. Click | accept to accept the software license agreement.
5. Click Install.
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Installing Login VSI target software on the launcher
1. Browse to VSlinstall media\setups\Launcher\.

Run setup.exe.

In the Target Setup wizard, specify the VSI share.
Click Start.

Reboot the system.

Shut down the launcher VM.
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Converting the launcher VM to a template

1. InvSphere Client, right-click the launcher VM, and select Template> Convert to Template.
Deploying the launchers VM from the launcher template

1. InvSphere Client, browse to Home—>VMs and Templates.
Right-click the launcher template to deploy a virtual machine from the template.

Type launcher 1 asthe new VM name, and click Next.

Click Datacenter, and click Next.

Click on the launcher server, and click Next.

Select the appropriate storage, and click Next.

Select customization using existing customization specifications, select the appropriate file, and click Next.
Click Finish to deploy the new VM.

Repeat steps 1 through 8 to deploy more launchers.
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Configuring VSI Launchers for testing
After all 24 launchers are configured and in an idle state, configure the login VSI test harness to add them to available
launcher capacity.
1. Logonto VSI_Share as DOMAIN\administrator
Open the Login VSI management console.
Click “2. Add Launchers”
At the Add launchers wizard, click Next.
Click batch entry and enter the following:

vk wnN

Name=launcher
Start number=1
Increment=1
Count=24

Maximum capacity=30
Formatting length=2

6. Click Next.
7. Click Finish.

Running the Login VSI benchmark
Before we ran our test, we executed assign_user.ps1 on the VMWare view server and statically assigned

login_VSI users to virtual desktops so persona data would not be created randomly in testing. Next, we ran a profile

create job in Login VSI to fully initialize each user’s profile. Finally, we used twenty-four launchers to run a medium
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workload with a launch interval of 20 seconds in benchmarking mode. See Appendix C for detailed settings use. For

more information on how to run a Login VSI test, see www.loginvsi.com/documentation/index.php?title=Main Page.

Setting up DVD Store database VMs
We set up four Server 2012 VMs, each with 4 vCPUs and 12 GB of RAM. We installed and configured them with
Microsoft Windows Server 2012 and Microsoft SQL Server 2012.

Setting up the virtual machine
1. Connect to vCenter via the VMware vSphere Web client.
Click the Virtual Machines tab.
Right-click, and choose New Virtual Machine.
Choose Custom, and click Next.
Enter the name of the virtual machine, and click Next.
Select the first host, and click Next.
Select the first LUN for the storage, and click Next.
Choose Virtual Machine Version 9, and click Next.
Choose Windows, choose Microsoft Windows Server 2012 (64-bit), and click Next.
. For CPUs, select one virtual processor socket, with four cores per virtual socket, and click Next.
. Choose 64GB RAM, and click Next.
. Click 1 for the number of NICs, select VMXNET3, connect to the vSwitchO network, and click Next.
. Leave the default virtual storage controller, and click Next.
. Choose to Create a new virtual disk, and click Next.
. Set the OS virtual disk size to 85GB, choose thick-provisioned lazy-zeroed, specify the OS datastore on the
external storage, and click Next.
16. Keep the default virtual device node (0:0), and click Next.
17. Click Finish.
18. Right-click the VM, and choose Edit Settings.
19. Click the Resources tab, and click Memory.
20. Select reserve all guest memory, and click OK.
21. Connect the VM virtual CD-ROM to the Microsoft Windows Server 2012 installation disk.
22. Start the VM.

Installing the VM operating system on the first SQL VM
1. Atthe Language Selection Screen, click Next.

LWooNOU R WN

e
U h WNRO

2. Click Install Now.
3. Select Windows Server 2012 Enterprise (Full Installation), and click Next.
4. Click the | accept the license terms checkbox, and click Next.
5. Click Custom.
6. Click Next.
7. Atthe User’s password must be changed before logging on warning screen, click OK.
8. Enter the desired password for the administrator in both fields, and click the arrow to continue.
9. At the Your password has been changed screen, click OK.
10. Install the latest Host Integration Tools package on the VM. Restart as necessary.
11. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
12. Enable remote desktop access.
13. Change the hostname, and reboot when prompted.
14. Create a shared folder to store test script files. Set permissions as needed.
15. Set up networking:
a. Click Start=>Control Panel, right-click Network Connections, and choose Open.
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b. Right-click the VM traffic NIC, and choose Properties.
c. Select TCP/IP (v4), and choose Properties.
d. Assign the VM a static IP address.

16. Shut down the VM.

17. Clone the VM three times.

Installing and configuring Microsoft SQL Server 2012
We installed Microsoft SQL Server 2012 on the VMs residing on the systems under test.

Configuring the SQL Server VM
After cloning, modify the SQL VM to contain two additional virtual disks:

e 130 GB virtual disks for SQL database (Thick provisioned, eager-zeroed)

In the VM, configure the VM storage:

In the taskbar, click the Server Manager icon.

In the left pane, expand Storage, and click Disk Management.

Right-click the first volume, and choose Initialize Disk.

In the right pane, right-click the volume, and choose New Simple Volume...

At the welcome window, click Next.

At the Specify Volume Size window, leave the default selection, and click Next.

At the Assign Drive Letter or Path window, choose the appropriate a drive letters for E:\ and I:\, and click Next.
At the Format Partition window, choose NTFS, and click Next.

At the Completing the New Simple Volume Wizard window, click Finish.

Installing Microsoft SQL Server 2012
1. Open the console for the VM or connect to the VM with RDP.
2. Mount the installation ISO to the VM.
3. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2012 DVD, and
double-click.
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4. |If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.

5. Inthe left pane, click Installation.

6. Click New SQL Server stand-alone installation or add features to an existing installation.

7. Atthe Setup Support Rules screen, wait for the rule check to complete. If there are no failures or relevant
warnings, click OK.

8. Select the Specify a free edition from the drop-down menu, and select Evaluation. Click Next.

9. Click the checkbox to accept the license terms, and click Next.

10. If no failures are displayed after the setup support files are installed, click Next.

11. At the Setup Role screen, choose SQL Server Feature Installation.

12. At the Feature Selection screen, select Database Engine Services, Full-Text and Semantic Extractions for Search,
Client Tools Connectivity, Client Tools Backwards Compatibility, Management Tools — Basic, and Management
Tools — Complete. Click Next.

13. At the Installation Rules screen, click Next after the check completes.

14. At the Instance configuration screen, leave the default selection of default instance, and click Next.

15. At the Disk Space Requirements screen, click Next.

16. At the Server Configuration screen, check that NT AUTHORITY\SYSTEM is selected for SQL Server Agent and SQL
Server Database Engine. Click Next.

17. Assuming there are no failures, click Next.

18. At the Database Engine Configuration screen, select Mixed Mode.

19. Enter and confirm a password for the system administrator account.

20. Click Add Current user. This may take several seconds.
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21. Click the Data Directories tab, and enter the appropriate drive and folders for database and logs.

22. Click Next.

23. At the Error and usage reporting screen, click Next.

24. At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click
Next.

25. At the Ready to Install screen, click Install.

26. After installation completes, click Close.

27. Create a SQL Server login for the ds2user (see the Configuring the database (Data generation overview) section
for the specific script to use).

28. Copy the pre-created DVD Store backup to the specified backup volume.

29. Download and install any available updates for Microsoft SQL Server 2012. We installed SQL Server 2012 SP1
and CUS.

Configuring the database workload client
For our testing, we used a virtual client for the Microsoft SQL Server client. To create this client, we installed

Windows Server 2008 R2, assigned a static IP address, and installed .NET 3.5.
Configuring the database

Data generation overview
For each Database VM, we generated data using the Install.pl script included with DVD Store version 2.1 (DS2),

providing the parameters for our 20GB database size and the database platform on which we ran Microsoft SQL Server.

We ran the Install.pl script on a utility system running Linux. The Install.pl script also generated the database schema.

After processing the data generation, we transferred the data files and schema creation files to a Windows-
based system running SQL Server 2012. We built the 20GB database in SQL Server 2012, and then performed a full
backup, storing the backup file for quick access. We used that backup file to restore the server between test runs.

The only modification we made to the schema creation scripts were the specified file sizes for our database. We
explicitly set the file sizes higher than necessary to ensure that no file-growth activity would affect the outputs of the
test. Besides this file size modification, the database schema was created and loaded according to the DVD Store
documentation. Specifically, we followed these steps:

1. We generated the data and created the database and file structure using database creation scripts in the DS2
download. We made size modifications specific to our 20GB database and the appropriate changes to drive
letters.

We transferred the files from our Linux data generation system to a Windows system running SQL Server.

We created database tables, stored procedures, and objects using the provided DVD Store scripts.

We set the database recovery model to bulk-logged to prevent excess logging.

We loaded the data we generated into the database. For data loading, we used the import wizard in SQL Server

Management Studio. Where necessary, we retained options from the original scripts, such as Enable Identity

Insert.

We created indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.

7. We updated statistics on each table according to database-creation scripts, which sample 18 percent of the
table data.

8. Onthe SQL Server instance, we created a ds2user SQL Server login using the following Transact SQL (TSQL)
script:
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USE [master]
GO
CREATE LOGIN [ds2user] WITH PASSWORD=N'"',
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DEFAULT DATABASE=[master],

DEFAULT LANGUAGE=[us english],

CHECK EXPIRATION.=OFF,
CHECK POLICY=OFF

GO

9. We set the database recovery model back to full.

10. We created the necessary full text index using SQL Server Management Studio.
11. We created a database user and mapped this user to the SQL Server login.

We then performed a full backup of the database. This backup allowed us to restore the databases to a pristine

state relatively quickly between tests. Figure 52 shows our initial file size modifications.

Logical name Filegroup Initial size (MB)
Database files

primary PRIMARY 3.25
custl DS_CUST_FG 5,767
cust2 DS_CUST_FG 5,767
ind1 DS_IND_FG 2,621
ind2 DS_IND_FG 2,621
ds_misc DS _MISC_FG 2,621
ordersl DS_ORDERS 2,621
orders2 DS_ORDERS 2,621
Log files

ds_log Not Applicable 20,480

Figure 52: Our initial file size modifications.

Configuring the database workload client

For our testing, we used two client machines. To create these clients (DVDS-C1 and DVDS-C2), we installed
Windows Server 2012 on two VMs. Each VM was created with 2 vCPUs and 8 GB of RAM. We installed .NET 3.5. on each.

Installing and configuring Microsoft LoadGen

Creating an Exchange server VM

1. Connect to vCenter via the VMware vSphere Web client.

Click the Virtual Machines tab.

Choose Custom, and click Next.
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10. Choose 4GB RAM, and click Next.

Right-click, and choose New Virtual Machine.

Assign a name to the virtual machine, and click Next.
Select the Microsoft Exchange Datastore on the external storage, and click Next.
Choose Virtual Machine Version 9, and click Next.
Choose Windows, select Microsoft Windows Server 2012 (64-bit), and click Next.
Choose 1 virtual socket, and 4 virtual processors per core, and click Next.
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11.
12.
13.
14.
15.
16.
17.
18.
19.

Click 1 for the number of NICs, select vmxnet3, and click Next.

Leave the default virtual storage controller, and click Next.

Choose to create a new virtual disk, and click Next.

Make the virtual disk size 90 GB, and choose thick-provisioned lazy zeroed.

Keep the default virtual device node (0:0), and click Next.

Click Finish.

Right click the VM, select Upgrade Virtual Hardware, and click Yes.

Start the VM.

Attach the Windows Server 2012 I1SO image to the VM, and install Windows Server 2012 on your VM.

Installing the operating system on the exchange client the VM

See the above sections regarding the initial creation of the virtual machines. We provide steps below for

installing the operating system.

Installing the VM operating system on the VM

1.
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Connect to the ISO image of the installation DVD for Windows Server 2012 Enterprise from the VM console.
If the ISO image is not stored on the host, start the VM first and then connect to the ISO image.

Start the VM.

At the Language Selection Screen, click Next.

Click Install Now.

Select Windows Server 2012 Enterprise (Full Installation), and click Next.

Click the | accept the license terms checkbox, and click Next.

Click Custom.

Click Next.

At the User’s password must be changed before logging on warning screen, click OK.

. Enter the desired password for the administrator in both fields, and click the arrow to continue.

. At the Your password has been changed screen, click OK.

. Install the latest VMware Tools package on the VM. Restart as necessary.

. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
. Change the hostname and reboot when prompted.

. Create a shared folder to store test script files. Set permissions as needed.

. Set up networking:

a. Click Start=>Control Panel, right-click Network Connections, and choose Open.

b. Right-click the VM traffic NIC, and choose Properties.

c. Select TCP/IP (v4), and choose Properties.

d. Setthe IP address, subnet, gateway, and DNS server for the virtual NIC, which will handle outgoing server
traffic. Click OK, and click Close.

Installing and configuring Microsoft Exchange Server
We cloned our exchange VM three times on server c1-s7 and then joined each to the domain.local domain. We
installed Microsoft Exchange 2010 SP3 on each of the four Exchange VMs.
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Configuring the Exchange 2010 VM

1.

ok wnN

N

10.

11.
12.

13.

14.
15.

Installing .
1.
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10.

Power on the machine.

Select Start—>Control Panel->Network Connections—>Ethernet.

Click Properties.

Highlight Internet Protocol (TCP/IP), and click Properties.

Select the Use the following IP address radio button, and enter the desired IP for your testing network.
Select the Use the following DNS server addresses radio button, and enter the IP of the AD server in the
Preferred DNS server field. Click OK.

Right-click My Computer, and select Properties.

Under the Computer Name tab, click Change.

In the Computer Name Changes screen, under Computer name, type exc01

In the Computer Name Changes screen, under the Member of section, select the Domain radio button, and
type domain.local

To start joining the domain, select OK.

When the screen appears asking for a person qualified on the domain, type administrator as the
username and the password.

At the Welcome pop-up and the window warning that you must restart the computer for the changes to
take effect, click OK.

At the System Properties screen, click OK.

When a pop-up appears asking if you want to restart now, click Yes to restart your machine.

NET Framework 3.5.1 Features and Internet Information Services

Select Start—>Administrative Tools=>Server Manager.

Click Features.

Click Add Features.

Select .NET Framework 3.5.1 Features.

Click Add Required Role Services.

Click Next.

Click Next.

At the Select Role Services screen, click the checkboxes for 1IS 6 Metabase Compatibility, 1IS 6 Management
Console, Basic Authentication, Windows Authentication, Digest Authentication, Static content compression,
and Dynamic content Compression, and click Next.

At the Confirm Installation Selections screen, click Install.

At the Installation Results screen, click Close.

Installing Microsoft Filter Pack

1.
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Download the Microsoft Filter Pack from
www.microsoft.com/downloads/en/details.aspx?FamilylD=5cd4dcd7-d3e6-4970-875e-aba93459fbee.
Run FilterPackx64.exe.

Click Next.

Click | accept the terms in the License Agreement, and click Next.

When the installation is complete, click OK.

Fusion-io Virtualization Reference Architecture: A Principled Technologies reference architecture 67
Deploying Server and Desktop Virtualization on
Fusion ioControl Hybrid Storage, Cisco UCS, and VMware


http://www.microsoft.com/downloads/en/details.aspx?FamilyID=5cd4dcd7-d3e6-4970-875e-aba93459fbee

Installing Exchange Server

1. Click Start, type services.msc and press Enter.

Right-click the Net.Tcp Port Sharing service, and click Properties.

Change the Net.Tcp Port Sharing startup type to Automatic, and click OK.

Open command prompt, type ServerManagerCmd —i RSAT-ADDS and press Enter.
Reboot the VM.

Mount the installation ISO to the VM and click Setup.exe when prompted.

The installer should consider steps 1 and 2 complete, and gray them out.

Click the link for Step 3: Choose Exchange Language Option.
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Click Install only languages from the DVD.
. Click the link for Step 4: Install Microsoft Exchange Server 2010 SP1.
. To go past the introduction screen, click Next.
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. Accept the license agreement, and click Next.
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. Select No for error reporting, and click Next.
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D

. Select Typical Exchange Server Installation, and click Next.
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. Leave the organization name as the default (First Organization), and click Next.

[E
[<)]

. At the question about client computers running Outlook 2003 and earlier, select Yes, and click Next.
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. Click Next to accept defaults for Configure Client Access server external domain.
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(oo}

. At the Customer Experience Improvement Program screen, select | don’t want to join the program at this
time, and click Next.

19. If a warning about a lack of SMTP appears after the check finishes, ignore it.

20. To start the installation process, click Install.

21. Once installation is complete, click Finish.

22. Click OK when prompted to reboot.

23. Click Close.

24. To confirm closing, click Yes.

25. Reboot the VM.

Installing SP3 for Microsoft Exchange 2010
1. Download Service Pack 3 for Microsoft Exchange 2010 (Exchange2010-SP3-x64.exe) from
www.microsoft.com/en-us/download/details.aspx?id=36768 to c:\SP3 on the VM.

To extract the installation files, double-click the downloaded file.

To accept the destination directory for the extracted files, click OK.

To launch the installer, double-click setup.exe.

Click Install Microsoft Exchange Server upgrade.

At the Introduction screen, click Next.

Accept the terms in the license agreement, and click Next. The Readiness Checks should begin.
Install any roles in Server Manager that the Readiness Checks prompt you to install.
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. When the checks successfully complete, click Upgrade.
10. Click Finish, and reboot the VM.
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Configuring Exchange Server 2010 connector

1.
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8.
9.
10
11

In the VM, Select Start—>All Programs—> Microsoft Exchange Server 2010~ Exchange Management Console.
In the left pane, click Microsoft Exchange On-Premises.
In the left pane, expand Organization Configuration, and select Hub Transport.
In the action pane on the far right, select New Send Connector.
Name the send connector SMTP, select the intended use as Internet, and click Next.
In the Address space screen, click Add.
In the SMTP Address Space screen, type * as the address, ensure that the installer has checked Include all
subdomains, and click OK.
Click Next.
To accept defaults for the next two pages, click Next.
. At the New Connector page, click New to create the connector.
. To close the New SMTP Send Connector wizard, click Finish.

Configuring the Exchange Server 2010 Mailbox role

1. Select Start>All Programs—>Microsoft Exchange Server 2010 Exchange Management Console.

2. Inthe left pane, expand Organization Configuration, and click Mailbox.

3. Click the Database Management tab.

4. Right-click Mailbox Database, and select Properties.

5. Select the Maintenance tab.

6. Check the Enable circular logging box.

7. Check the box beside This database can be overwritten by a restore.

8. Next to Maintenance interval, click Customize.

9. Remove all blue from the boxes so the system will not perform maintenance, and click OK.

10. Click OK.

11. Click OK to any warnings about circular logging being applied after the database is remounted.

12. On the far right pane, click Move Databases.

13. Change the Database file and Log folder path locations to point to the two additional attached virtual disks,
and click Move.

14. If the application prompts you to dismount, click Yes.

15. Click Finish.

16. Right-click Public Folder Database, and select Properties.

17. Check the Enable circular logging checkbox, and uncheck the ESE scanning checkbox.

18. Next to Maintenance interval, click Customize.

19. Remove all blue from the boxes so the system will not perform maintenance, and click OK.

20. Click OK.

21. On any warnings about circular logging being applied after the database is remounted, click OK.

22. On the far right pane, click Move Database.

23. Change the Database file and Log folder path locations to point to the two additional attached virtual disks
respectively, and click Move.

24. If the application prompts you to dismount, click Yes.

25. Click Finish.
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Installing and configuring the Exchange 2010 mail test client (LGC01)
For our testing, we used a virtual client for the LoadGen workload. To create this client, we installed Windows
Server 2012 on a VM with 1 vCPU and 4 GB of RAM.

Join LGCO1 to the domain
1. Logonto LGCO1.
Select Start->Control Panel>Network Connections—>Local Area Connection.
Click Properties.
Highlight Internet Protocol (TCP/IP), and click Properties.
Select the Use the following IP address radio button, and enter the desired IP for your VM.
Select the Use the following DNS server addresses radio button, and enter the IP of the AD server in the
Preferred DNS server field. Click OK.
Right-click My Computer, and select Properties.
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Under the Computer Name tab, click Change.

9. Inthe Computer Name Changes screen, under Computer name, type 1gc01 as your computer name.

10. In the Computer Name Changes screen, under the Member of section, select the Domain radio button. Type
domain.local and select OK.

11. When the screen appears asking for a person qualified on the domain, type administrator as the
username and the admin password.

12. At the Welcome pop-up and the window warning that you must reset the computer for the changes to take
effect, click OK.

13. At the System Properties screen, click OK.

14. When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

Installing Internet Information Services
1. When LGCO1 reboots, login as DOMAIN\administrator

2. Click Start=>Administrative Tools—>Server Manager.
3. Onthe left pane, click Roles.
4. Click Add Roles.
5. Click the Application Server checkbox.
6. When the Add features required for Application Server? screen appears, click Add Required Features.
7. Click Next.
8. Click Next.
9. Atthe Select Role Services page for Application Server, click the Web Server (IIS) Support checkbox.
10. Click Add Required Support Role Services.
11. Click Next.
12. Click Next.
13. At the Select Role Services page for Web Server (IIS), click IIS 6 Management Compatibility, ASP, and CGI
checkboxes; and click Next.
14. Click Install.
15. Click Close.
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Installing Load Generator 2010

1.

Download and install Load Generator 2010 using all defaults.

Preparing Load Generator

1. Loginto the mail client using the tester account.

2. Select Start=>All Programs—> Microsoft Exchange—> Exchange Load Generator 2010.

3. When the Load Generator screen appears, select Start a new test.

4. Select Create a new test configuration, and click Continue.

5. Change the total length of simulation to 90 minutes.

6. Inthe Specify test settings screen, type the password for Directory Access Password and Mailbox Account
Master Password, and click Continue with recipient management.

7. Make 400 users in the Mailbox Database, and click Continue.

8. To accept defaults for Advanced recipient settings, click Continue.

9. Inthe Specify test user groups screen, select the plus sign to add a user group.

10. Change the Client Type to Outlook 2007 Cached, the Action Profile to Exchange_200, and the Mailbox size to
250 MB.

11. In Remote configurations, click Continue.

12. Click Save the configuration file as, and name it testcfg.xml

13. After saving the configuration file, click Start the initialization phase (recommended before running the test).
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APPENDIX C—- METHODOLOGY FOR ADDITIONAL PROCEDURES
Deploying the ioSphere VM
We took the following steps to deploy the ioSphere VM:

Download the appliance.

Start the vSphere client and log in to vCenter as a vSphere admin.
From the vSphere client, click File > Deploy OVF Template and choose the iosphere-vme.ova from step 1.
Accept the licensing agreement, and click Next.

Select the data center, and click Next.

Select the infrastructure host, and click Next.

Select the storage (NASO1).

Select thick provisioned lazy zeroed, and click Next.

Select the priv-net network, and click Next.

10. Enter the password, gateway, and DNS addresses, and click Next.
11. Click power on after deployment, and click Finish.
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Configuring the ioSphere VM

We took the following steps to configure the ioSphere VM:

In vSphere client, open a KVM session to the ioSphere VM.
Set the time zone.

Note the management IP address.

Close the KVM.

Open a browserto https://<address from step 3>
Log in as admin.
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Installing host drivers and configuring ioTurbine

We took the following steps to install the host drivers and configure ioTurbine.

1. Copy the following files to /vmfs/volumes/DAS:
o libvsl-1.0.0-vsl.3.2.6.1219.zip
o fio_iot_offline_bundle_esx50.zip
o scsi-iomemory-vsl-5X-3.2.6.1219-offline_bundle-1377628.zip
o block-iomemory-vsl-5X-3.2.6.1219-offline_bundle-1377628.zip
2. From the ESXi command line, run:
o esxcli software vib install -
d/vmfs/volumes/DAS/fio iot offline bundle esx50.zip
o esxcli software vib install -d/vmfs/volumes/DAS/1libvsl-1.0.0-
vsl.3.2.6.1219.zip
o esxcli software vib install -d/vmfs/volumes/DAS/scsi-iomemory-vsl-
5X-3.2.6.1219-0offline bundle-1377628.zip
o esxcli software vib install -d/vmfs/volumes/DAS/block-iomemory-vsl-—
5X-3.2.6.1219-0offline bundle-1377628.zip
3. Reboot the appliance.
4. InvCenter, host c1-s7 now has a Fusion ioSphere tab. Select it, and click the adaptor on the left. Select low-
level format.
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APPENDIX D — DETAILED VIRTUAL MACHINE CONFIGURATION

Figure 53 shows the detailed information of the virtual machine we used in testing.

Mem | vDisk
VM name Qty 0s Role Host(s) LUN | vCPUs (GB) (GB)
DC1 1 Windows 2008 R2 | Active Directory, DNS, DHCP | Infral-3 | NASO1 2 4 100
VSI_Share 1 Windows 2008 R2 | Login VSl share Infral-3 | NASO1 2 2 100
{;Jl\s/lphere 1 Virtual appliance | Fusion-io 10 mgmt server Infral-3 | NASO1 2 4 60
vCenter 1 Windows 2008 R2 | VMware vCenter Infral-3 | NASO1 2 8 100
Composer 1 Windows 2008 R2 | VMware Composer Infral-3 | NASO1 2 2 100
View 1 Windows 2008 R2 | VMware View server Infral-3 | NASO1 2 4 100
saL 1 | Windows 2008 R2 Zﬁfvffr’ and Composer DB || o1 3 | naso1 2 4 100
LO1-124 24 Windows 7 (x64) | Login VSI Launcher Infral-3 | NASO1 2 8 40
LGCO1 1 \ZA(/)TSOWS Server | . change client Infral-3 | NASO1 1 4 40
DVDS-C1,2 | 2 \ZA(/)TSOWS Server | 5L7p clients Infral-3 | NASO1 2 4 40
g&wom_ 600 Windows 7 (x86) | VMware Virtual Desktop c1-s5-8 \éDT A- 1 1 24

Windows Server DVD-

SQL01-04 4 5012 OLTP, SQL server cl-s4 saL 4 12 130
EXC01-04 4 \2/\(/)|{1;ows Server LoadGen Exchange server cl-s4 gzchan 4 4 90

Figure 53: Detailed information for our virtual machines.
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APPENDIX E — LOGIN VSI FILES

VSILauncher.ini
[Scenario]

CPUEnabled=enabled
NumberOfCPU=8
CoresEnabled=enabled
NumberOfCores=64
HyperThreadingEnabled=enabled
HostsEnabled=enabled
NumberOfHosts=4

[Launcher]
BaselLinePhase=1

Servername=
Username=
Password=enc:BD177557C81239CECl:enc
ShowPassword=C0403E14874E
Domain=
useCsv=1

CCL="C:\Program Files\VMware\VMware View\Client\bin\wswc.exe" -serverURL
view -username %csv_username$ -password *****x** —domainName domain-
desktopName pool -standAlone -logInAsCurrentUser False -nonInteractive#

CSv=\\vsishare\share\ccl.csv
PhasesCount=1
NumberOfSessions=600
Sequentiallnterval=4
AutoLogoff=1
LogoffTimeOut=300
CreateProfile=0
TSDiscon=0
PreTestScript=
PostTestScript=
BaselLinePhaseSessions=5
BaseLinePhaseSamples=5
BaselineSampleInterval=3

BaselinePhaselInterval=6
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BaselLinePhaseTotalTime=105
Fancy Number=0
[VST]
SkipAddLaunchersScreen=0
SkipCommandLineScreen=0
SkipStartTestScreen=0
[Phasel]
Name=Benchmarking Phase
Sessions=600
PhaseTime=2880
Pause=False
[LauncherWorkload]
launcherUsername=domain\launcher
launcherPassword=enc:BD177557C81239CECl:enc
launcherWorkflow=0
limitConcurrent=10
launcherResolution=1024x768
launcherDisconnectAfterLaunch=0
[Phase?2]

Global.ini
[Logon]
ImportOfficeReg=1
CopyPST=1
MapUserHome=1
MapGroupDrive=1
SetFreemindFTA=1
EngineStartup=Shell
[Settings]
Workload Language=English
Office version=14
Office Language=English
office print sequence={altdown}fpp{altup}
Engine Debug=0
Workload Debug=0
PDFPrinting=1
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Pause={Pause}

Workload Loops=99999

Logoff Action=shutdown /1
UserHome=H:

Groupdrive=G:

LogoffAt=segment
SegmentsPerFile=20
RandomInitialWait=5

log category AppStart=True

log category LoopTimer=False
log category RandomCopy=False
log category SegmentTimer=False
IEVersion=Auto
IEVideoOption=Auto

winwait timeout=120
winwaitactive timeout=120

timer timeout=60
logout on fatal error=l
Workload=medium

Benchmark Mode=1

[GUI]

Fancy=0

Mode=Compact

Assign user.psl

SMaxrun = 600

for(si = 1; $i -le S$Maxrun; Si++)
{

vdmadmin -L -d pool -m vdt-$i.ToString("000") -u domain\LoginVSIS$i
}
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ABOUT PRINCIPLED TECHNOLOGIES

We provide industry-leading technology assessment and fact-based

P marketing services. We bring to every assignment extensive experience
Principled with and expertise in all aspects of technology testing and analysis, from
Technologies® researching new technologies, to developing new methodologies, to

testing with existing and new tools.

When the assessment is complete, we know how to present the results

to a broad range of target audiences. We provide our clients with the
Principled Technologies, Inc. materials they need, from market-focused data to use in their own
1007 Slater Road, Suite 300 collateral to custom sales aids, such as test reports, performance

Durham, NC, 27703
www.principledtechnologies.com

assessments, and white papers. Every document reflects the results of
our trusted independent analysis.

We provide customized services that focus on our clients’ individual
requirements. Whether the technology involves hardware, software,
Web sites, or services, we offer the experience, expertise, and tools to
help our clients assess how it will fare against its competition, its
performance, its market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked
together in technology assessment for over 20 years. As journalists,
they published over a thousand articles on a wide array of technology
subjects. They created and led the Ziff-Davis Benchmark Operation,
which developed such industry-standard benchmarks as Ziff Davis
Media’s Winstone and WebBench. They founded and led eTesting Labs,
and after the acquisition of that company by Lionbridge Technologies
were the head and CTO of VeriTest.

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER,
PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND
ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL
PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC.,
ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE ON ACCOUNT OF
ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN'NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S
LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING.
CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.
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